Arterial Destiffening With Weight Loss in Overweight and Obese Middle-Aged and Older Adults

Ana Laura Dengo Flores

Dissertation submitted to the faculty of Virginia Polytechnic Institute and State University in partial fulfillment of the requirements for the degree of

Doctor of Philosophy

In

Human Nutrition, Foods and Exercise

Kevin P. Davy, Chair
Brenda M. Davy
Madlyn I. Frisard
Barbara J. Nicklas

June 15, 2010
Blacksburg, VA

Keywords: arterial stiffness, obesity, weight loss, aging
Arterial Destiffening With Weight Loss in Overweight and Obese Middle-Aged and Older Adults

Ana Laura Dengo Flores

ABSTRACT

Cardiovascular diseases (CVD) are the leading cause of mortality in the United States. Aging is the major risk factor for CVD development, which is independently predicted by arterial stiffness (AS). Arterial stiffening is closely related to age-related arterial structural/functional changes and obesity. Therefore, obese middle-aged and older adults are considered a high CVD risk population. In light of the current obesity epidemic and the projected growth of the older population, there is an overwhelming need to determine if weight loss (WL) may reduce AS (CVD risk) in this population. Thus, we hypothesized that WL via a hypocaloric diet-alone would reduce AS in overweight and obese middle-aged and older adults. To test our hypothesis, baseline assessment of anthropometrics, blood pressure and AS was conducted, and subjects were randomized to a 12-week WL intervention or a control group. Arterial stiffness was measured using applanation tonometry to estimate carotid-femoral artery pulse wave velocity (C-F PWV), and with high-resolution ultrasonography of the carotid artery (β-SI). There were no baseline differences between groups in our variables of interest. Consistent with our hypothesis, both measures of AS were significantly reduced (C-F PWV = -16% and β-SI = -12%, $P<0.05$) with WL (-8%, $P<0.05$). Weight loss also resulted in significantly decreased blood pressure, total body and abdominal fat. No such changes were observed in the control group. Pooled correlation analysis suggests
that the magnitude of change in C-F PWV was not associated with changes in systolic, diastolic or mean blood pressure. We further hypothesized that reductions in AS, if observed, would be associated with the magnitude of reduction in total body or abdominal adiposity. Concordant with our hypothesis, the reductions in C-F PWV were significantly associated with total and abdominal fat. However, linear regression analysis indicate that neither total body nor abdominal body fat were capable of independently predicting reductions in C-F PWV. Our findings suggest that moderate WL in overweight and obese middle-aged and older adults is an efficacious treatment strategy for reducing AS. Further studies are needed to determine if the improvements in arterial compliance would be sustained with long-term WL maintenance.
ACKNOWLEDGEMENTS

I am very grateful to my committee members for their support and guidance. I would especially like to thank Dr. Kevin Davy and Dr. Brenda Davy for welcoming me into their lab and supporting me over the years. I would also like to extend my gratitude to my lab mates for their help, friendship and constant encouragement. Very importantly, I am extremely thankful to Roberto, mami, Gaby, and all my family for their unconditional love, friendship, and support throughout the years.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract</td>
<td>ii</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>iv</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>v</td>
</tr>
<tr>
<td>List of Tables</td>
<td>viii</td>
</tr>
<tr>
<td>List of Figures</td>
<td>ix</td>
</tr>
<tr>
<td>Chapter I: Introduction</td>
<td>1</td>
</tr>
<tr>
<td>References</td>
<td>3</td>
</tr>
<tr>
<td>Chapter 2: Review of Literature</td>
<td>5</td>
</tr>
<tr>
<td>A. Cardiovascular disease mortality and morbidity</td>
<td>5</td>
</tr>
<tr>
<td>B. Aging and cardiovascular disease prevalence/mortality</td>
<td>5</td>
</tr>
<tr>
<td>C. Economic cost of cardiovascular diseases</td>
<td>6</td>
</tr>
<tr>
<td>D. Age-related weight gain and body composition changes</td>
<td>6</td>
</tr>
<tr>
<td>E. Prevalence of overweight/obesity in middle aged and older adults</td>
<td>7</td>
</tr>
<tr>
<td>F. Visceral obesity and cardiac health in older adults</td>
<td>8</td>
</tr>
<tr>
<td>G. Arterial stiffness and cardiovascular health</td>
<td>9</td>
</tr>
<tr>
<td>H. Risk factors for arterial stiffness development</td>
<td>10</td>
</tr>
<tr>
<td>H.1 Aging</td>
<td>11</td>
</tr>
<tr>
<td>H.2 Obesity</td>
<td>11</td>
</tr>
<tr>
<td>H.3 Visceral adiposity</td>
<td>12</td>
</tr>
<tr>
<td>CONTENTS</td>
<td>PAGE</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>H.4 Sympathetic nervous system</td>
<td>12</td>
</tr>
<tr>
<td>H.5 Local vasoactive factors</td>
<td>13</td>
</tr>
<tr>
<td>H.6 Inflammatory/oxidative stress</td>
<td>14</td>
</tr>
<tr>
<td>I. Measurements of arterial stiffness</td>
<td>16</td>
</tr>
<tr>
<td>I.1 Pulse wave velocity</td>
<td>16</td>
</tr>
<tr>
<td>I.2 Ultrasound imaging</td>
<td>18</td>
</tr>
<tr>
<td>I.3 Augmentation index</td>
<td>19</td>
</tr>
<tr>
<td>I.4 Central blood pressure</td>
<td>20</td>
</tr>
<tr>
<td>I.5 Pulse pressure</td>
<td>20</td>
</tr>
<tr>
<td>I.6 Pulse pressure amplification</td>
<td>21</td>
</tr>
<tr>
<td>J. Treatment strategies for arterial stiffness</td>
<td>22</td>
</tr>
<tr>
<td>J.1 Weight management</td>
<td>22</td>
</tr>
<tr>
<td>J.2 Nutritional therapy</td>
<td>26</td>
</tr>
<tr>
<td>J.3 Pharmaceutical treatment</td>
<td>29</td>
</tr>
<tr>
<td>K. Conclusions</td>
<td>32</td>
</tr>
<tr>
<td>References</td>
<td>33</td>
</tr>
<tr>
<td>CONTENTS</td>
<td>PAGE</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Chapter III: Arterial destiffening with weight loss in overweight</td>
<td></td>
</tr>
<tr>
<td>and obese middle-aged and older adults</td>
<td>45</td>
</tr>
<tr>
<td>Abstract</td>
<td>45</td>
</tr>
<tr>
<td>Introduction</td>
<td>47</td>
</tr>
<tr>
<td>Materials and Methods</td>
<td>48</td>
</tr>
<tr>
<td>Results</td>
<td>52</td>
</tr>
<tr>
<td>Discussion</td>
<td>55</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>59</td>
</tr>
<tr>
<td>Sources of Funding</td>
<td>60</td>
</tr>
<tr>
<td>Disclosures</td>
<td>60</td>
</tr>
<tr>
<td>References</td>
<td>60</td>
</tr>
<tr>
<td>Chapter IV: Conclusions and future directions</td>
<td>74</td>
</tr>
<tr>
<td>Appendices</td>
<td>78</td>
</tr>
<tr>
<td>Appendix A: Measurement of arterial stiffness indices</td>
<td>78</td>
</tr>
<tr>
<td>Appendix B: Informed consent for subjects</td>
<td>94</td>
</tr>
<tr>
<td>Appendix C: Institutional Review Board Approval</td>
<td>101</td>
</tr>
<tr>
<td>Appendix D: Citation of the published manuscript</td>
<td>108</td>
</tr>
</tbody>
</table>
LIST OF TABLES

CHAPTER III:          PAGE

Table 1.                      64
Subject characteristics before and after the control or weight loss intervention.

Table 2.                      66
Frequency of medication use.

Table 3.                      67
Physical activity and dietary intake before and after the control or weight loss intervention.

Table 4.                      68
Indices of arterial stiffness before and after the control or weight loss intervention.

Table 5.                      69
Correlations between changes indices of arterial stiffness with the intervention and other variables.
LIST OF FIGURES

CHAPTER III

Figure 1. 71
Change in β-stiffness index following control and weight loss intervention (top panel).
Change in arterial compliance following control and weight loss intervention (middle panel). Change in C-F pulse wave velocity following control and weight loss intervention (bottom panel). PWV=pulse wave velocity. Values are means±SE. *P<0.05 vs. control

Figure 2. 72
Relation between changes in β-stiffness index and percent weight loss in the pooled sample (panel A); relation between changes in C-F pulse wave velocity and percent weight loss (panel B); relation between changes in C-F pulse wave velocity and changes in visceral fat (panel C); and relation between changes in C-F pulse wave velocity and changes in waist circumference (panel D). PWV=pulse wave velocity.

Figure 3. 73
Relation between changes in mean arterial pressure and change in carotid-femoral pulse wave velocity. PWV=pulse wave velocity.
APPENDICES:  PAGE

Figure A1.  78
Illustration of the arterial segment measured for the quantification of carotid-femoral PWV.

Figure A2.  79
Calibration of the Windaq software.

Figure A3.  81
Example of pulse waves recorded at the carotid (top) and femoral (bottom) artery (master file).

Figure A4.  82
Selection of pulse waveforms for analysis.

Figure A5.  83
Example of pulse waves with compression =1.

Figure A6.  83
Example of the Windaq command screen.

Figure A7.  84
Example of the command screen used to mark the channels to be analyzed.
APPENDICES: PAGE

Figure A8. 85
Illustration of the original channels (1&2) and the copied and marked channels (3&4).

Figure A9. 85
Marked carotid and radial (bottom) pulse waves for peripheral PWV determination.

Figure A10. 88
Calibration of the carotid artery blood pressure using applanation tonometry and brachial blood pressure measured via an automated monitor.

Figure A11. 91
Calibration step for the determination of arterial diameters.

Figure A12. 92
Selection of the ROI.

Figure A13. 92
Calculation of an arterial diameter.
CHAPTER I

Introduction

In the last 3 decades the prevalence of overweight has almost doubled in the US adult population (1980=47.4% and 2008=68%) \(^1\). Currently, 1 in 3 US citizens is classified as obese according to their BMI levels \(^1,2\). This overweight/obesity epidemic is not only present in the US and other developed countries, but is now a reality in many developing countries as well. Although great emphasis has been placed on battling this public health problem the prevalence of obesity continues to rise among all age groups \(^2\). Obesity is considered a chronic disease which may be a triggering factor for the development of other diseases, including cardiovascular diseases (CVD), diabetes, steatosis, cholelithiasis, osteoarthritis, sleep apnea, non-alcoholic fatty liver disease, certain cancers, among others \(^2,3\).

Aging and increasing central adiposity are associated with each other \(^1\), and both are significantly related to the increased clustering of metabolic CVD risk factors. Older individuals are at a greater risk for suffering from chronic diseases, which means that the almost doubled percent distribution of older (>65 yrs) US citizens by 2030 \(^1\) may be accompanied with a significantly greater prevalence of obesity and its co-morbidities. The projected growing number of obese older adults suffering from other diseases may represent a considerable financial and personnel toll on the health care system. Furthermore, life expectancy in the US has been affected directly by obesity and its co-morbidities\(^4,5\).
Cardiovascular diseases continue to be the leading cause of death in the US\textsuperscript{1}. Advancing age is the main risk factor for CVD development. In addition, aging\textsuperscript{6-9} and obesity\textsuperscript{7, 10, 11} contribute significantly to the development of arterial stiffness. Arterial stiffness is defined as a loss in compliance (i.e., the change in volume for a given change in pressure) resulting from functional (i.e., decreased nitric oxide bioavailability) and/or structural (i.e., altered collagen to elastin ratio) changes in the vasculature. Importantly, arterial stiffness is an independent predictor of CVD morbidity\textsuperscript{12-18} and mortality\textsuperscript{6, 12, 15, 19}.

Increased accumulation of fat in the visceral depot, and stiffening of large arteries is common throughout the lifespan. Total body and abdominal visceral fat have been correlated with arterial stiffness in cross-sectional studies\textsuperscript{7, 11}. It is believed that mild weight loss of 5 to 10\% of initial body weight can significantly decrease health risks, possibly including improvements in central arterial stiffness. However, whether weight loss reduces arterial stiffness is not clear, particularly among obese middle-aged and older adults. As such, we tested the hypothesis that a hypocaloric diet alone would reduce arterial stiffness in overweight and obese middle-aged and older adults. We also sought out to study the possible relationship between the magnitude of visceral fat loss and reductions in arterial stiffness.


CHAPTER II:
Review of Literature

A. Cardiovascular disease mortality and morbidity

Over the last 60 years cardiovascular diseases (CVD) have been the leading cause of death in the United States\(^1\). During 2006, 26% of all deaths were attributed to heart disease\(^1\). In addition, diseases of the heart were responsible for 1078 out of 7214 potential years of life lost before age 75 per 100,000 adults\(^1\). The most common CVD among adults is hypertension which affects 1 in 3 individuals. Other frequently observed CVD include coronary heart disease, myocardial infarction, angina pectoris, stroke, and heart failure\(^2\).

B. Aging and cardiovascular disease prevalence/mortality

The prevalence of hypertension among all US adults is 33-37%, and it increases significantly with advancing age\(^2\). For example, the percent prevalence of hypertension in middle-aged adults is approximately 54%, and this prevalence increases to approximately 71% and 65% in women and men aged 65-74 years, respectively\(^1\).

The risk of CVD mortality increases drastically as a result of aging. The existent mortality rate for heart disease at ages 35-44 years more than triples when crossing into the 45-54 year old age bracket\(^1\). Subsequently, the death rate attributed to CVD each decade, i.e., 55-64 years, at least doubles until age 84 years\(^1\). In addition, adults age
65 years and older that die from a CVD comprise 81% of coronary heart disease and 86% of stroke victims.

C. Economic cost of cardiovascular diseases

Heart and vascular pathologies may limit the degree of mobility, work capacity-disability, and quality of life of middle-aged and older adults. Consequently, the financial burden for treating CVD not only affects the patients and their families but also impacts the work place, the health-care system infrastructure and the economy overall. The estimated cost of CVD for 2010 in the US is $503.2 billion, and if the gradual increase in obesity prevalence, diabetes, and related metabolic risk factors continues among all age groups the economic cost associated with CVD will rise exponentially.

The US Census Bureau has projected that by 2030 older adults will represent 20% of the population. Since older adults are at a higher risk for chronic diseases, the twofold increase in the size of this population may result in greater occurrence of CVD and other morbidities which may represent an additional financial and personnel toll on the health care system.

D. Age-related weight gain and body composition changes

Most adults gain weight gradually throughout their lifetime at an average rate of 1-2 lbs per year. Weight gain is likely the result of decreases in physical activity and the gradual increase of energy intake during the last 25-30 years. In the period from 1980 – 2006, middle-aged males (40-59 yrs) and females increased their daily energy intake by approximately 380 and 350 Kcal, respectively. In addition, males older than
60 yrs increased their daily energy intake by an average of 230 Kcal and older females by approximately 310 Kcal.

With aging, the increase in abdominal adiposity is characterized by a greater increase in visceral compared to subcutaneous adipose tissue in both men and women\textsuperscript{5}. Waist circumference strongly correlates with visceral fat stores in various populations, including the elderly\textsuperscript{6, 7}. Furthermore, gender-specific waist circumference reference values increase gradually each decade from 40 to 70 years of age\textsuperscript{1}. For both genders, there are several contributing factors to this increased accumulation of visceral fat with advancing age, such as decreasing growth hormone levels and changing sex hormone levels\textsuperscript{8}.

E. Prevalence of overweight/obesity in middle-aged and older adults

The prevalence of overweight/obesity in most age groups has increased drastically over the last three decades, and there is no sign of this trend abating\textsuperscript{1, 9}. In 2007-2008, 68\% of the adult population over 20 years of age in the US was considered overweight/obese according to their BMI classification\textsuperscript{9}. The prevalence of overweight among middle-aged and older women was similar to that of the general population. The prevalence of obesity in men older than 40 years of age was approximately 10\% higher compared to women.

The age-adjusted adult obesity prevalence in 2008 was 33.8\%\textsuperscript{9}. Middle-aged males and older females had an obesity frequency similar to all adults in the US. In contrast, older men and middle-aged women were approximately 4-5\% more obese. Women between 40 and 59 years of age have been the demographic with the highest
obesity prevalence during the last decade. In addition, middle-aged women had an almost doubled prevalence of type II and III obesity compared to their male-counterparts\textsuperscript{9}.

**F. Visceral obesity and cardiac health in older adults**

Aging and increasing central adiposity are significantly related to the increased clustering of metabolic and CVD risk factors\textsuperscript{5, 8, 10-12}. Although aging is the major contributor to the development and progression of cardiovascular pathologies, it is important to consider the additive/synergistic effects that other classical and emerging risk factors may have on cardiovascular health. Individuals with at least 3 risk factors have a threefold risk of suffering from a myocardial infarction, and a twofold risk of dying from a heart attack\textsuperscript{13}. The presence of visceral obesity, defined as deep intra-abdominal fat, has been reported to reduce life expectancy by as much as 8 years. Furthermore, the increased accumulation of intra-abdominal fat increases the risk of developing diseases such as hypertension and ischemic heart\textsuperscript{14}.

Visceral adiposity is better predictor of CVD than body weight and BMI\textsuperscript{15}. The amount of visceral fat predicts the incidence of myocardial infarctions in females but not in male participants in their seventh decade\textsuperscript{16}. However, elevated visceral fat in older adults increases the risk of developing heart failure independently of other CV risk factors\textsuperscript{12}. Taken together, the results of numerous studies suggest that abdominal adiposity is associated with adverse metabolic risk factors, as well as higher risk for all-cause and cardiovascular mortality.
Arterial compliance is defined as the ability of an artery to expand and recoil in response to changes in intravascular pressure. Arterial stiffness (reduced arterial compliance) is determined primarily by the content of elastin and collagen in the arterial wall and vascular smooth muscle tone. The arterial aging process and the increased presence of metabolic risk factors negatively influence arterial function and structure. Structural changes include breakdown of elastin, increased production of collagen, altered elastin:collagen ratio, cross-linking of collagen with advanced glycation end-products, calcification, and plaque formation. Increased elastase activity and the deteriorating ability to repair tissue significantly contribute to cyclically injure the vascular wall.

In addition, arterial distensibility is decreased as a result of reduced nitric oxide production and/or bioavailability resulting in increased vasoconstrictor tone. Cross-sectional studies have clearly demonstrated an inverse association between endothelial function and arterial stiffness. Therefore, it should not come as a surprise that endothelial dysfunction also predicts both CVD and all-cause mortality. The buffering capacity of the aorta is diminished with stiffening leading to a decreased ability to transform the pulsatile flow exerted by ventricular ejection into steady flow, thereby causing damage to the arterial wall. Blood flow velocity is significantly higher in stiff arteries compared to more compliant arteries. Therefore, forward pulse waves reach reflecting sites considerably faster causing the reflected waves to arrive at the proximal aorta earlier during late systole instead of at diastole. The early arrival of
the reflected wave reduces diastolic time \(^{24}\) leading to decreased coronary perfusion. Also, the higher aortic afterload pressure in less compliant arteries results in higher systolic blood pressure.

Higher systolic pressure combined with decreased diastolic blood pressure causes widening of the pulse pressure which is associated with numerous adverse cardiovascular events, i.e, stimulation of left ventricle hypertrophy and remodeling \(^{25}\). Thickening and hypertrophy of the left ventricle adds to the increased cardiac workload resulting from arterial stiffening. Other vasculature changes observed with arterial stiffening include increased mean diameter, reduced pulsatile diameter, decreased endothelial function, increased development of connective tissue, and reduced pulse pressure amplification.

Arterial stiffness is an independent predictor of all-cause mortality \(^{26, 27}\), CVD morbidity \(^{28-36}\) and mortality \(^{28, 31, 37, 38}\) in many different populations. The association between arterial stiffening and risk of CVD mortality has been observed in hypertensives \(^{39}\), individuals with end-stage renal disease \(^{26, 40}\), and the elderly \(^{28, 31, 41}\). Furthermore, arterial stiffness is considered to be a marker of target organ damage \(^{42}\).

**H. Risk factors for arterial stiffness development**

Aging is the main risk factor for the development of arterial stiffness \(^{36, 38, 43-45}\). However, obesity, visceral adiposity, dyslipidemia, oxidative and inflammatory stress, hypertension, impaired glucose tolerance, diabetes, smoking, physical inactivity, and genetics exert an important modulatory influence on arterial stiffness \(^{23, 46-49}\). Arterial
stiffening is higher among middle-aged and older adults with 3 or more risk factors compared to those with 2 or less risk factors\textsuperscript{50}.

**H.1 Aging.** With aging and accumulation of fat around the abdominal region, central stiffness increases more significantly than peripheral arterial stiffness. The aging-arterial stiffening relationship is not strictly linear and modifiable risk factors, i.e., nutrition and exercise, may weaken the correlation. For several decades it has been demonstrated that older adults normally have higher arterial stiffness compared to young controls \textsuperscript{45}. Modifiable factors such as cardiorespiratory fitness may protect older adults from the age-related arterial stiffening. Endurance trained older adults, i.e., master athletes, have reduced arterial stiffness compared with sedentary older adults \textsuperscript{45}. Cross-sectional measures of arterial compliance in individuals with different physical activity levels suggest that compliance is highest in endurance trained individuals compared to those who are sedentary or recreationally active \textsuperscript{51}. This relationship persisted across different age groups, and there was no significant difference in arterial compliance between middle-aged and older endurance trained adults. In addition, an exercise intervention by Tanaka and colleagues \textsuperscript{51} demonstrated that sedentary middle-aged and older adults improve their arterial compliance after participating in a 3 month aerobic exercise program, independent of changes in blood pressure and anthropometric measures. Taken together, these findings suggest that regular aerobic exercise can prevent age-related arterial stiffening.

**H.2 Obesity.** Studies focusing on overweight and obese individuals have shown that they have increased arterial stiffness, and that this association remains across age groups. Even though BMI is significantly associated with arterial stiffness, total body fat
and percent body fat are considered better indicators of structural-functional alterations in the vasculature. Obese individuals have greater aortic stiffness compared to their normal weight counterparts even at younger ages \textsuperscript{43}.

\textbf{H.3 Visceral adiposity.} Body fat distribution, especially visceral fat measures, better describes the relationship with arterial stiffening than total body fat. Our laboratory has demonstrated that even in younger and normal weight males intentional weight gain (5 Kg) resulting in a significant increase in visceral adiposity is associated with increased carotid artery stiffness \textsuperscript{52}. Furthermore, the observed changes in arterial stiffness only correlated with measures of total abdominal fat, visceral fat, and waist circumference, and were independent of total body fat gain \textsuperscript{52}. The reduction in arterial stiffness with weight loss middle-aged and older adults is also correlated with the reductions in waist circumference and visceral fat.

\textbf{H.4 Sympathetic nervous system.} Obesity is associated with higher sympathetic nervous system activity, as demonstrated by cross-sectional studies comparing the levels of muscle sympathetic nerve activity (MSNA) of obese and non-obese individuals \textsuperscript{53-55}. Gentile and colleagues \textsuperscript{56} suggest that a 5 Kg weight gain induced by experimental overfeeding in young non-overweight males increases MSNA by 15-20% after a 4-wk post weight gain stabilization period. To our knowledge, there are very few articles that directly address the possible relationship between sympathetic nerve activity and arterial stiffness in humans. A recent report indicates that in non-obese healthy adults (average age: 43 yrs) MSNA is positively and independently associated with arterial stiffness \textsuperscript{57}.
**H.5 Local vasoactive factors.** Reduced endothelial derived nitric oxide (NO) production or bioavailability is strongly related to arterial stiffening of the large elastic arteries. NO sends signals to the arterial wall \(^{58}\) to maintain hemostasis by stimulating vasodilation of smooth muscle cells, and inhibiting adhesion of platelets and leukocytes to the arterial wall, among many other signaling functions \(^{58,59}\).

C-type natriuretic peptide is a vasodilator, mostly produced by endothelial cells, which has protective properties (i.e., anti-inflammatory and anti-atherogenic properties) \(^{60,61}\). Individuals with low C-natriuretic peptide levels are believed to have increased arterial stiffness, which translates to increased CVD risk \(^{60}\).

Increased levels of angiotensin II, mediator of the renin-angiotensin-aldosterone system (RAAS), are related to increased levels of arterial stiffness \(^{58}\). Some of the means by which angiotensin II contributes to the development of arterial stiffening are: promotion of cell growth, pro-inflammatory / pro-oxidative properties, reduction of NO bioavailability \(^{62}\). Elevated aldosterone levels may also be implicated in arterial stiffening as a result of its effect on sodium reabsorption, blood pressure elevation, and increasing collagen content in the arterial wall \(^{58}\).

Endothelin-1 is a vasoconstrictor that has also been implicated in the development of arterial stiffness. Two, of the many, stimuli for endothelin-1 production are angiotensin II and oxidized-LDL \(^{63}\). Increased levels of endothelin-1 lead to endothelial dysfunction, and its plasma concentration tends to decrease with arterial destiffening interventions.
**H.6 Inflammatory/oxidative stress.** Inflammatory and oxidative mediators often have a negative effect on NO production and bioavailability, while having a stimulatory effect on components of RAAS and vasoconstrictors like endothelin-1. Therefore, they have been implicated as promoting factors for endothelial dysfunction, vascular remodeling, and the initiation and progression of atherosclerosis.  
Metabolites, inflammatory signals, reactive oxygen species (ROS), and products of endoplasmic reticulum stress become part of a “vicious cycle” response leading to the chronic low grade inflammation and metabolically stressed state observed in the obese.

**C-Reactive Protein (CRP) and Interleukin-6 (IL-6).** A well-designed and controlled study of healthy individuals with a BMI < 27 Kg/m² demonstrated that acutely induced systemic inflammation (via *Salmonella typhi* injections) is related with acute elevations in arterial stiffness. Interestingly, at 8 hours post baseline both arterial stiffness and circulating inflammatory markers, CRP, IL-6, and MMP9 (matrix metalloproteinase 9), were elevated. However, at 32 hours arterial stiffness levels were almost back to baseline, and the inflammatory markers had also decreased except for CRP values which actually increased. Therefore, the recorded arterial stiffness values for 32 hours did not have a positive relationship with CRP, and it appears that IL-6 correlated better with stiffness. Administration of a non-steroidal anti-inflammatory before the *s. typhi* injection, still resulted in increased circulating levels of the inflammatory markers but no significant increases in arterial stiffness were observed. In this substudy, there was a stronger correlation between arterial stiffness and CRP levels while no correlation was observed with IL-6.
Although many studies have confirmed the positive association between circulating CRP levels and central arterial stiffness \(^{66-68}\), it remains unclear if this is a causal-effect relationship. Recently, no associations were observed between CRP genotypes and aortic PWV, suggesting that CRP is not a causal factor for arterial stiffness development \(^{67, 69}\).

**Adiponectin.** Adiponectin is expressed solely by adipose tissue, and is inversely associated to total body fat mass and measurements of central arterial stiffness \(^{68}\). This anti-inflammatory protein acts on the liver and skeletal muscle resulting in improved glucose and lipid metabolism. Adiponectin protects the vasculature through the increased production of nitric oxide in endothelial cells \(^{15}\). Furthermore, adiponectin has anti-atherosclerotic properties by inhibiting monocyte adhesion and macrophage infiltration in the vasculature \(^{15}\).

The positive effect of adiponectin on arterial stiffness also depends on the presence of pro-inflammatory markers, and the resulting pro-inflammatory / anti-inflammatory ratio. Classification of subjects according to both their adiponectin and CRP levels revealed that individuals with highCRP-lowAdiponectin levels had the highest arterial stiffness, while those that had lowCRP-highAdiponectin levels had the lowest central stiffness values \(^{68}\). Furthermore, participants with highCRP-highAdiponectin or lowCRP-lowAdiponectin levels had almost the same levels of arterial stiffness, which fell right in the middle of the worst and best pro-inflammatory / anti-inflammatory profile \(^{68}\).
Blood lipids and reactive oxygen species. The obese-state is characterized by increased delivery of fatty acids to the liver and heightened activity of hepatic lipase resulting in adverse lipid profiles, i.e., higher small-dense LDL-cholesterol levels and the reduction of HDL-cholesterol. Small-dense LDL-cholesterol negatively affect arterial function because they are prone to glycation and oxidation, are able to enter the vascular subendothelial space more easily, and are also taken up by macrophage scavenger receptors 64.

Epidemiological data indicates that oxidized-LDL levels increase as the BMI of older adults increases 70. In addition, oxidized-LDL levels are positively related to arterial stiffening, independent of classical CVD risk factors and demographic characteristics 70. ROS directly impairs arterial compliance by interfering with NO bioavailability and NO signaling 71. Vascular superoxide production (assessed ex vivo from human vascular tissue) is also negatively associated with arterial compliance 72 leading to arterial stiffening.

I. Measurements of arterial stiffness

Arterial stiffness can be measured by a variety of methods. Below is a description of several validated methods frequently used for research purposes.

I.1 Pulse wave velocity (PWV). Pulse waves travel faster along stiff-arteries, and alterations on this velocity are linked with changes in the vasomotor tone, arterial calcification and arterial wall integrity, and the distance between branching points 42. As such, the current gold standard for central arterial stiffness measurement is carotid-femoral artery pulse wave velocity, a surrogate measure for aortic PWV 23. The velocity
at which pulse waves travel is calculated by dividing the carotid-femoral arterial distance by the travel time estimated by the foot-to-foot method $^{23}$. PWV is a blood pressure dependent measure, therefore it is very important to allow enough supine resting time, 15-20 minutes, in order for the individual's blood pressure to stabilize. PWV values obtained non-invasively via transcutaneous tonometers are well correlated with intra-aortic magnetic resonance imaging $^{73}$ and angiography $^{74}$ methods to calculate PWV. In addition, PWV values obtained via tonometers in middle-aged adults who are abdominally obese but otherwise healthy correlate better with age, peripheral and central pulse pressure compared to MRI measured PWV $^{73}$. Large epidemiological studies have indicated that central PWV has a superior capacity over other stiffness measures when it comes to predicting the occurrence of new cardiovascular and cerebrovascular events such as myocardial infarction, heart failure, unstable angina, and stroke $^{32}$.

CF-PWV is sometimes criticized because of the human error that may be involved when calculating the travel distance with a tape measure. Three popular methods for determining the pulse travel distance include the following: measuring the direct linear path from the carotid to the femoral artery; measuring the before mentioned path and subtracting the distance from the carotid artery to the suprasternal notch; and subtracting the distance between the carotid artery and the suprasternal notch from the distance between the notch and the femoral artery.

Pulse wave travel distances obtained via angiography were compared with non-invasive distance measurements to help answer the debate of which is the appropriate method to measure distances between the arterial sties $^{74}$. The direct distance
measurement from the carotid to the femoral artery is the one that may lead to overestimation by as much as 300 cm/s. Adjusting the path traveled by subtracting the distance from the carotid artery to the suprasternal notch from the directly measured carotid-femoral artery distance may result in an overestimation of 140 cm/s. Finally, subtracting the carotid artery-sternal notch distance from the notch-femoral artery distance provides the most accurate estimate for aortic PWV.  

It is difficult to compare measurements of PWV across studies because of the different methodologies used to record the travel distance. Defining only one method to measure the pulse wave travel distance would contribute significantly to arterial stiffness related research and also for the possible introduction of clinical reference values. In the mean time, Vermeersch and colleagues have developed mathematical equations to convert direct distance measurements into subtracted distance measures or vice versa PWVs calculated with directly obtained distances and the mathematically calculated distances were very similar and differ only by 2-5 cm/s.

1.2 Ultrasound imaging. High resolution ultrasonography has become a useful tool in assessing arterial stiffness. The carotid artery is commonly imaged to analyze diameter changes between systole and diastole. Ultrasound imaging of the common carotid artery is a very reliable measure that can be combined with simultaneous applanation tonometry recordings of the contralateral carotid artery to calculate β-stiffness index (β-SI), a blood pressure independent index of local arterial stiffness. Ultrasounds are also used to calculate non-invasively the elastic properties of arteries and the intima-media thickness.
1.3 Augmentation index (Alx). The Alx is calculated from the enhancement in systolic blood pressure as a result of the arrival time of the reflected waves. Stiffening of the arteries result in the earlier arrival of the reflected waves during systole, therefore the quicker summation of the backward wave with the forward wave reduces wave length and increases amplitude leading to wider pulse pressures. Therefore, Alx is considered an indirect marker of arterial stiffness, and is positively and independently associated with endothelial dysfunction. The Alx is able to predict the onset of cardiovascular events in hypertensives, and all-cause and CVD mortality in end-stage renal disease patients.

The blood pressure wave can also be analyzed by studying the transit-time independent measures separately. Carotid pressure waveform recordings of adults were broken down into the forward wave, backward wave, reflection index, reflected wave transit time, and augmentation pressure to determine which component or combination of components is able to predict CVD mortality independently of PWV. The researchers demonstrated that during a 15 year follow-up period the backward wave was the only independent predictor of CVD mortality for both genders. A post-hoc analysis of individuals according to age (> or < 55 years) suggested that in the younger subgroup PWV, augmentation pressure and the backward wave predicted CVD mortality. However, in middle-aged and older subjects only PWV and the backward wave had predictive capacity of all-cause mortality. These findings indicate that both augmentation index and augmentation pressure underestimate the degree to which the reflected wave affects mortality risk.
1.4 Central blood pressure. Central blood pressure is considered a better predictor of adverse cardiovascular events and aortic stiffness compared to brachial blood pressure\textsuperscript{22}. In addition, central blood pressure may have an impact on target organ damage, particularly the heart, brain and kidneys\textsuperscript{22}. Intra-aortic methods exist to measure central blood pressure directly, nonetheless, these methods are very invasive, time and cost consuming, and not readily available at different health facilities. Therefore, it is very helpful to be able to calibrate central BP from the carotid artery pulse waveform via applanation tonometry and brachial BP. Currently, applanation tonometry is mostly used in research settings but measuring central blood pressure in a non-invasive and time-efficient manner at a cardiologist’s office would greatly improve the care received by patients with a high risk for suffering from cardiovascular diseases.

1.5 Pulse pressure. Increased amplitude of the pulse waveforms indicates widening of the pulse pressure, which is considered an indirect measure of arterial stiffness\textsuperscript{23}. Pulse pressure is calculated by subtracting diastolic blood pressure from systolic pressure, and it is considered a hemodynamic indicator of conduit artery stiffness\textsuperscript{17}. Factors such as heart rate, cardiac contractility, and venous pressure also influence pulse pressure\textsuperscript{79}. Higher pulse pressures have been shown to induce arterial remodeling, increase wall thickness, and plaque development\textsuperscript{31, 80}. Central pulse pressure is capable of predicting all cause-mortality and the risk of developing CVD\textsuperscript{29, 81}.

The clinical importance of calculating the pulse pressure of hypertensive patients is sometimes overlooked. There are some anti-hypertensive medications which are very efficient in lowering systolic blood pressure but also lower diastolic blood pressure excessively resulting in wider pulse pressures. In addition, individuals who suffer from
isolated systolic hypertension have normal or low diastolic blood pressures so the use of medications that lower both systolic and diastolic blood pressures may affect health negatively. Accordingly, peripheral pulse pressure should not be used as a surrogate measure for central pulse pressure.

I.6 Pulse pressure amplification (PPA). In adults higher PPA is related with lower levels of central arterial stiffness and reduced CVD risk and . Both diastolic pressure and mean arterial pressure remain fairly constant throughout the entire arterial tree. However, systolic blood pressure tends to amplify as a result of decreasing vessel size from the central to the distal arteries. Determinants of PPA include age, gender, heart rate, arterial integrity, i.e., elasticity and collagen:elastin ratio, distance from central arteries to the reflecting site, characteristics of the reflected wave, large-artery stiffness, and metabolic risk factors.

Usually PPA is calculated using the pulse pressure at the carotid (aortic) and brachial arteries, and there is not much literature focused on the importance of measuring PPA from the carotid to the femoral artery. As a result of the arterial stiffening effects of advancing age and increased intra-abdominal adiposity, stiffening of the central arteries tends to be greater over the lifespan compared to peripheral arteries. Thus incorporating central PPA measures to research protocols that already calculate peripheral PPA may contribute important insights to the progression or treatment of arterial stiffness.
**J. Treatment strategies for arterial stiffness**

The first step in preventing and treating CVD should always be lifestyle modification, which includes body weight management, incorporating healthy eating habits, being more physically active, minimization of mental stress, not smoking, as well as limiting intake of alcoholic beverages. Depending on the severity of the disease pharmacological treatment is also warranted, as well as combination of treatment methods. Below is a review of different treatment options for arterial stiffness.

**J.1 Weight Management**

*Weight Loss --Diet alone.* A limited number of research groups have attempted to elucidate the effect of diet-induced weight loss on arterial stiffness. Most agree that weight loss via dietary interventions leads to improved arterial compliance\(^{84-91}\). However, methodological issues and the lack of adjustment for possible confounding variables make it difficult to determine if the destiffening effect may be solely attributable to the diet-induced weight loss. To our knowledge, the study of Balkenstein et al.\(^{84}\) is the only randomized controlled trial. The experimental design of this study included both exercise and diet to achieve approximately a 15% weight loss in obese adults\(^{84}\).

Diet-alone weight loss studies lasting 12 weeks resulted in significant reductions in PWV and \(\beta\)-SI, increased arterial compliance, and improved endothelial function\(^{88, 91}\). Larger-scale interventional studies in different populations are needed to gain further insight into the efficiency of diet-induced weight loss in reducing arterial stiffness, to better understand if a dose (% weight loss) - response effect (destiffening) exists, and to investigate if the improvements in arterial function are maintained over time.
Miyaki and colleagues 88 reported improvements in endothelial function after weight loss by measuring endothelin-1 (decreased ~32%) and nitric oxide (increased ~62%); however, the small sample size may impair generalizing the results. In comparison, Pierce et al. 91 did not observe significant changes in endothelin-1 or in inflammatory status in men and women across a large age-range; nonetheless, endothelial function improved with weight loss as a result of significant increases in nitric oxide bioavailability.

**Weight loss --Exercise alone**

Overweight/obese individuals who exercise 3 times per week for 40-60 min (walking-jogging) may benefit from significant improvements in arterial function even when the percent body weight loss achieved is low (3.7%) 92. The improved endothelial function associated with exercise is independent of age and blood pressure, and may be related to the percent body fat and waist circumference loss, plus significant reductions in endothelin-1 92.

Healthy middle-aged and older regular aerobic exercisers have better endothelial function compared to healthy age-matched sedentary peers 93 as a result of improved nitric oxide bioavailability 94, and greater ROS scavenging capacity 95. In addition, sedentary middle-aged and older men enrolled in a daily moderate intensity exercise (walking) intervention improve their tissue plasminogen activator release independent of body composition changes 96, which contributes to the maintenance of fibrinolytic balance via physical activity.
Weight loss --Diet and exercise therapy

The combination of a dietary regimen and substantial physical activity normally results in weight loss. The main goal of nutrition and exercise treatment protocols should be to provide continual, clear and concise information/tools which may motivate the participants to adopt life-long healthy habits. Weight loss research trials often yield very different results because of the methodology used, and this may result in a collection of confounding literature regarding the health benefits of weight loss, healthy nutrition habits, and exercise.

Nutrition plus exercise interventions in young and middle-aged adults lasting 12-24 weeks result in approximately 8-15% weight loss, reductions in systolic and diastolic blood pressure of 5-10 mmHg and 0-8 mmHg respectively, improved metabolic profile, and increased arterial elasticity \(^{84, 89}\). The increased elasticity may be related to improved glucose and lipid homeostasis, and reductions in markers of inflammation (i.e., CRP and fibrinogen) \(^{89}\). An efficacy treatment comparison of diet-alone or diet plus exercise on arterial distensibility indicates that when equal amounts of weight are lost (Kg, and %) there are no statistically significant response differences between groups\(^{84}\).

Weight loss maintenance

There is a significant research void in the area of weight loss maintenance (WTLM) and arterial stiffness. Weight loss has proven to be an effective treatment strategy for arterial stiffness, nonetheless, most interventions are of short/moderate-duration and do not include follow-up past the intervention. Examples of some relevant research questions regarding WTLM and arterial stiffness are: 1) are improvements in
arterial stiffness maintained if WTLM is achieved and no other arterial destiffening
treatment is incorporated? 2) will arterial stiffness rebound towards baseline levels
during the weeks/months after weight loss even when no weight gain occurs? 3) will
arterial compliance continue to improve if more weight is lost? 4) does the type of diet
employed to achieve weight loss affect the probability of sustaining the improvements in
arterial stiffness? 5) finally, what happens when regular aerobic exercise is
incorporated after the weight loss period? Further investigations are needed to answer
these intriguing questions, as well as many other related research questions.

**Physical activity without weight loss**

Regular aerobic exercise is recommended as a lifestyle modification to reduce
arterial stiffness. Several cross-sectional studies comparing the degree of arterial
stiffness in active versus sedentary individuals have shown that the arteries of regular
aerobic exercisers are more compliant. Exercise training interventions contribute to
reducing arterial stiffness in various study populations including postmenopausal
women, coronary artery disease patients, and hemodialysis patients. However,
other studies have reported that exercise does not improve arterial stiffness in older
isolated systolic hypertensives, and postmenopausal women with high blood
pressure. The varying results in studies involving aerobic exercise as a therapeutic
strategy to decrease arterial stiffness are likely due to the type of exercise, intensity,
duration and frequency of practice, and whether it is self-reported or monitored by a
research staff member.
J.2. Nutritional therapy

**Sodium restriction.** Modest reductions in daily sodium intake, similar to the public health recommendations, result in significant reductions in blood pressure in mild untreated hypertensives of different ethnicities \(^{102}\). Nonetheless, the observed reductions in PWV was only significant in African Americans, which had a higher baseline BMI, higher office and ambulatory blood pressure \(^{102}\). In contrast, another sodium restriction intervention suggests that significant improvements in arterial compliance may be achieved rapidly in normal weight older adults with mild hypertension \(^{103}\). Compared to baseline levels, sodium intake was reduced approximately 40% during the intervention which resulted in sustained improvements in arterial compliance throughout the 4 week study period \(^{103}\). Importantly, the observed improvements in arterial compliance were strongly associated (inversely) with reductions in systolic blood pressure \(^{103}\).

Restriction of dietary sodium in overweight postmenopausal women with elevated blood pressure was accompanied with significant reductions in PWV and Alx in comparison to an exercise group with no dietary sodium reduction \(^{101}\). The sodium restricted group remained sedentary throughout the study but still achieved a greater drop in blood pressure compared to the exercise group (daily walking 3-5.8 times/week for 30-45 min) \(^{101}\).

**Polyunsaturated fatty acids.** Levels of arachidonic and docosahexanoic fatty acids in plasma were found to be inversely related to central arterial stiffness measured via PWV. Further statistical analysis based on the principal components approach revealed that the cluster with high levels of arachidonic and eicosapentanoic and
docosahexanoic unsaturated fatty acids and low levels of oleic and palmitic and linoleic fatty acids was associated with lower systolic blood pressure, lower PWV values, and a decreased risk of mortality\textsuperscript{104}. Eicosapentanoic and docosahexanoic are omega-3 fatty acids found to have an attenuating effect on postprandial arterial stiffness of healthy individuals compared to meals containing other fatty acids\textsuperscript{105}. Also, intake of fish oil capsules, containing omega-3 fatty acids, increased large-artery elasticity compared to a placebo group, even in the absence of changes in blood pressure\textsuperscript{106}.

\textit{Antioxidants}. Antioxidant treatments often target the reduction of the already present oxidative/inflammatory stress (scavengers) but do not necessarily have an impact in reducing the production of ROS. Several physiological factors may influence the success of antioxidant treatment, such as a) site of production, b) pro-oxidant effects and dose, c) competitive substance kinetics, d) presence of required co-factors, e) biological half-life\textsuperscript{71}. Natural sources of antioxidants often work as scavengers, and chemical drugs are more likely to directly target the generation of ROS.

\textit{Examples of natural antioxidants: Vitamin C and E}. Research has mostly focused on studying the effects of vitamin C and E on endothelial function and arterial stiffness. A cause and effect study co-infused either acetylcholine (endothelium dependent dilation) or sodium nitroprusside (endothelium independent dilation) with vitamin C or saline to study the endothelium response to antioxidants\textsuperscript{107}. Co-infusions of saline and acetycholine demonstrated that obese individuals have an impaired endothelium response, while co-infusion of saline and sodium nitroprusside resulted in a similar increase in forearm blood flow across BMI classifications. Response to sodium
nitroprusside remained unchanged during co-infusion with vitamin C, while co-infusion with vitamin C resulted in an increase vasodilatory response to acetylcholine \(^{107}\).

Oral supplementation with vitamins C and E improved central arterial stiffness and endothelium dependent dilation in never treated essential hypertensives without changing central blood pressure \(^{108}\). In addition, reductions in malondialdehyde, which independently predicted PWV values, and decreased lipoperoxide levels contributed to beneficially altering the antioxidant/oxidant ratio after supplementation with vitamins. However, the results of this study cannot be generalized to populations with co-morbidities such as the obesity, dyslipidemia and diabetes because of the recruiting criteria employed. The efficacy of vitamin C supplementation on improving arterial function remains inconclusive. Oral supplementation with vitamin C did not acutely (baseline-8 hours) affect PWV, AIx, endothelium dependent dilation, blood pressure, and oxidative stress in young normal-weight healthy adults \(^{109}\).

**Example 2: Red wine.** The antioxidant properties of red wine have been highly publicized. Postprandial studies investigating the effect of red wine on arterial stiffness have suggested that 250-500 ml of this alcoholic beverage reduces PWV in normotensives \(^{110}\), decreases AIx in coronary artery disease patients \(^{111}\), and attenuates the stiffening effect of smoking a cigarette in healthy smokers \(^{112}\). Moderate intake of wine over 6 weeks decreased the AIx of postmenopausal women with high cholesterol \(^{113}\). Furthermore, dealcoholized red wine improved arterial stiffness in a similar fashion in all the studies previously mentioned except for the one conducted in normotensives \(^{110}\). Most of the antioxidants contained in red wine are present in the non-alcoholic red
wine \textsuperscript{114}, which explains the arterial destiffening efficacy of both wines; nonetheless, moderate consumption of alcohol has been credited with improving arterial compliance.

Red wine is a significant source of flavonoids \textsuperscript{113, 114}. Intake of two types of isoflavones, biochanin and formonomentin, for 6 weeks improved systemic arterial compliance, PWV, and total peripheral resistance in men and postmenopausal women not taking hormone replacement therapy \textsuperscript{115}. Isoflavones (subgroup of phytoestrogens) did not affect blood pressure or flow mediated dilation. Moreover, formonomentin proved to be the most effective isoflavone, and its intake was related with reductions in vascular cell adhesion molecule-1 (VCAM-1) \textsuperscript{115}. The cardiovascular health of obese adults also benefited from the intake of a metabolite of formonomentin and daidezein (type of isoflavone). The metabolite decreased PWV significantly after 5 weeks and these arterial stiffness changes were independent of the changes observed in blood pressure \textsuperscript{116}.

\textbf{J.3. Pharmaceutical treatment}

\textit{Anti-hypertensive drugs}

The choice in antihypertensive medication is very important given that not all drugs lower blood pressure equally along the arterial system \textsuperscript{76, 117}, and it is evident that central blood pressure is better related with cardiovascular pathologies \textsuperscript{22, 76}. The ideal anti-hypertensive drug would decrease both peripheral and central blood pressure and pulse pressure, decrease arterial stiffness, and decrease the augmentation index \textsuperscript{118}, thus having a greater impact on reducing CVD risk.
A review by Protogerou and colleagues\textsuperscript{119} summarized the effects of different anti-hypertensive medications on PPA according to their mechanism of action. Diuretics and $\beta$-blockers had no effect or decreased PPA, angiotensin II receptor blockers and calcium channel blockers either increased or had no effect on PPA, and angiotensin converting enzyme inhibitors and nitrates always increased PPA\textsuperscript{119}.

$\beta$-blockers may have an adverse effect on arterial stiffness\textsuperscript{118}, while angiotensin blockade therapy\textsuperscript{62,120} and calcium channel blockers improve arterial stiffness\textsuperscript{120}. Regular intake of 80-160 mg of valsartan, an angiotensin II receptor blocker, may improve carotid artery stiffness in older hypertensives. Interestingly, $\beta$-SI increased at 12 months of valsartan treatment but at 24 months decreased significantly from baseline levels\textsuperscript{62}. Unfortunately, this study only measured local carotid artery stiffness and did not include central arterial stiffness measures. Results from another 24-month long study including valsartan/hydrochlorothiazide and amlodipine (calcium channel blocker) suggest that central PWV decreased more significantly with valsartan both at 12 and 24 months compared to amlodipine in a group of well-controlled diabetics, even though both drugs achieved similar peripheral and central blood pressure and PP changes\textsuperscript{120}.

\textit{Lipid and glycemia lowering drugs}

Peroxisome proliferator-activated receptor (PPAR) agonists like pioglitazone (hypoglycemic) and fenofibrate (lipid lowering) reduce PWV approximately 16-17\% in a randomized controlled trial of obese middle-aged adults\textsuperscript{121}. The reductions in VCAM, was similar in both drug treatment groups. The fenofibrate group had greater reductions in ICAM (intracellular cell adhesion molecule) and TNF-$\alpha$ (tumor necrosis
factor α)\(^{121}\). In contrast, pioglitazone was the only drug to have positive effects on E-selectin and adiponectin levels, and IL-6 and insulin levels were reduced to a greater extent with the hypoglycemic drug treatment \(^{121}\).

Statins are cholesterol lowering drugs that inhibit HMG-CoA reductase, an essential reaction in cholesterol synthesis, and have been shown to have other beneficial health effects beyond its lipid lowering properties. Statins greatly influence endothelial cells, vascular smooth muscle cells, immune cells and platelets \(^{122}\). Statins are capable of reducing endothelial adhesion (E-selectin, VCAM, and ICAM), thrombosis (decreasing tissue factor and increasing thrombodulin and tissue plasminogen activator), inflammatory mediators, monocyte recruitment (MCP-1), matrix degradation (increasing tissue inhibitors of metalloproteinase and decreasing matrix metalloproteinases), smooth muscle cell migration, platelet activation (thromboxane A2), and may increase vasoreactivity (decreasing endothelin-1 and increasing endothelial nitric oxide synthase) \(^{122}\). Furthermore, statins may interact positively with PPARs.

We previously reported that high dose atorvastatin therapy (80 mg) during 12 weeks has a significant destiffening effect in overweight/obese middle-aged adults \(^{123}\). Future studies are needed to determine whether the arterial destiffening effect of atorvastatin follows a dose-response action, and if combination of statins with other destiffening treatments results in additive or synergistic effects.
**Breakers of collagen cross-links**

Drugs like alagebrium (ALT-711) effectively improve arterial function by breaking cross-links of collagen with advanced glycation end products. A small study with older obese isolated hypertensives showed that ALT-711 significantly reduces wave reflection even in the absence of significant changes in systolic blood pressure\textsuperscript{124}. In addition, endothelium dependent vasodilation increased after 8 weeks of ALT-711 treatment, possibly via improved nitric oxide production\textsuperscript{124}. In addition, increases in flow mediated dilation are inversely related to the synthesis of collagen and markers of vascular inflammation, i.e., p-selectin and ICAM\textsuperscript{124}.

**K. Conclusions**

Obese middle-aged and older adults are a high risk population for developing CVD. Obese adults are prone to have a clustering of the metabolic risk factors (i.e., hypertension, hyperglycemia, hyperinsulinemia, and increased abdominal fat storage) that contribute to the development of arterial stiffness. Increased arterial stiffness adversely affects cardiac function, impairs irrigation of the heart, elevates blood pressure levels throughout the arterial tree, as well as decreases vessel dilation and contraction abilities. Consequently, there is an overwhelming need to develop efficient and cost-effective weight management strategies that may result in weight loss-induced improvements in arterial stiffness. Furthermore, nutrition management of arterial stiffness should not be limited to body weight reduction but should also target increased consumption of foods/metabolites known to contribute to improvements in arterial compliance. Further research is needed to determine if combination treatments for
arterial stiffness (i.e., weight loss and statin, weight loss and exercise, statin and exercise) result in additive/synergistic effects on arterial compliance, and whether certain combination of treatments are more effective than others.

References


by external noninvasive devices and phase-contrast magnetic resonance imaging in the obese. *Hypertension*. 2009;54:421-426


83. Nichols WW. Clinical measurement of arterial stiffness obtained from noninvasive pressure waveforms. *Am J Hypertens*. 2005;18:3S-10S


123. Orr JS, Dengo AL, Rivero JM, Davy KP. Arterial destiffening with atorvastatin in overweight and obese middle-aged and older adults. Hypertension. 2009;54:763-768

CHAPTER III:
Arterial Destiffening With Weight Loss in Overweight and Obese Middle-Aged and Older Adults

ABSTRACT

We tested the hypothesis that weight loss via a hypocaloric diet would reduce arterial stiffness in overweight and obese middle-aged and older adults. Thirty-six individuals were randomly assigned to a weight loss (16 females, 9 males; age=61.2±0.8 years; BMI=30.0±0.6 kg/m$^2$) or a control group (5 females, 6 males; age=66.1±1.9 years; BMI=31.8±1.4 kg/m$^2$). Arterial stiffness was measured via carotid artery ultrasonography combined with applanation tonometry (for calculation of β-stiffness index [β-SI]) and carotid-femoral pulse wave velocity (CF-PWV) via applanation tonometry at baseline and following the 12-week intervention. Body weight, body fat, abdominal adiposity, blood pressure, β-SI, and CF-PWV were similar in the two groups at baseline (all P>0.05). Body weight (-7.1±0.7 vs. -0.7±1.1 kg), body fat, and abdominal adiposity decreased in the weight loss group but not in the control group (all P<0.05). Brachial systolic and diastolic blood pressures declined (P<0.05) only in the weight loss group. Central systolic and pulse pressures did not change significantly in either group. As hypothesized, β-SI (-1.24±0.22 vs. 0.52±0.37 U) and CF-PWV (-187±29 vs. 15±42 cm/s) decreased in the weight loss group but not in control (all P<0.05). The reductions in CF-PWV were correlated with reductions in total body and abdominal adiposity (r=0.357 and r=0.602, all P<0.05). However, neither total body nor abdominal adiposity independently predicted reductions in arterial stiffness indices. In
summary, our findings indicate that weight loss reduces arterial stiffness in overweight/obese middle-aged and older adults, and the magnitudes of these improvements are related to the loss of total and abdominal adiposity.

**Key Words:** Arterial Structure; Arterial Compliance; Aging; Pulse Wave Velocity; Caloric Restriction
Introduction

Arterial stiffness independently predicts cardiovascular disease (CVD) morbidity and mortality. Aging and obesity are positively associated with the development of arterial stiffness. Age-related structural (i.e., elastin to collagen ratio) and functional (i.e., bioavailability of nitric oxide) changes in the vasculature result in the loss of arterial compliance. Stiffening of the central aorta diminishes its buffering capacity, thus impeding the conversion of pulsatile flow to steady blood flow. Arterial stiffness leads to increased systolic blood pressure (SBP), decreased diastolic BP, widening of the pulse pressure, impaired coronary perfusion, left ventricle hypertrophy, increased cardiac workload, among other CVD.

Aging is also associated with increased accumulation of total body fat, especially in the abdominal region. Obese middle-aged and older adults often have a clustering of metabolic risk factors (i.e. increased visceral fat accumulation, hypertension, hyperglycemia, and hyperinsulinemia) which put them at a higher risk for severe arterial stiffening and adverse cardiovascular outcomes. Findings from lifestyle-modification interventions suggest that arterial stiffness is reduced with weight loss. However, several of these studies did not consider that the observed improvements in arterial stiffness may have been related to experimental design and/or confounding factors such as type of diet, physical activity, pleiotropic effect of medications, intake of multi-vitamin supplements, among other factors. Thus, it remains unclear whether intentional diet induced weight loss alone decreases arterial stiffness, particularly in a high CVD risk population such as overweight and obese middle-aged and older adults. We tested the hypothesis that weight loss via a hypocaloric diet alone would reduce arterial stiffness in
overweight and obese middle-aged and older adults. We further hypothesized that the reduction in arterial stiffness with weight loss, if observed, was associated with the magnitude of reduction in total body or abdominal adiposity.

**Materials and Methods**

**Subjects.** Thirty six weight stable (25<BMI<40 Kg/m$^2$) men (n=15) and women (n=21) between the ages of 55-75 years volunteered for the study. The subjects were free of overt disease (assessed by a Health History Questionnaire), were non-smokers, and did not take medications known to affect weight or appetite. Four subjects continued to take their prescription cholesterol lowering medicine (3 Lipitor, 1 Crestor), and three other stayed on their blood pressure medication (1 Hydrochlorothiazide, 1 Dyazide, 1 Lisinopril) for the duration of the study. These subjects had been taking their medication for at least 8 months before recruitment, and continued their drug regimen for the duration of the study. The Virginia Polytechnic Institute and State University Institutional Review Board approved the protocol. The nature, purpose, risks and benefits of participating were explained carefully to each subject before obtaining consent.

**Intervention.** Subjects were randomly assigned to a dietary intervention group (n = 25) and a control group (n = 11). After baseline testing, subjects underwent a 12 week weight loss (WL) period by following a low calorie diet (Females = 1200 Kcal, Males = 1500 Kcal), or a control period with no intervention. Control subjects were asked to maintain their current body weight, to not alter their dietary habits, and to maintain their habitual physical activity level. During the weight loss intervention period, subjects met
with a dietitian and had their body weight and blood pressure measured weekly. Subjects in the WL group were also instructed to not modify habitual physical activity. Participants randomized to the control group had monthly visits to measure body weight and blood pressure. Subjects were weight stable for at least 2 weeks before follow-up testing.

**Measurements.** All tests were performed between 8 and 11 am after a 12 hr fast. Subjects reported being free of illness the week prior and did not exercising vigorously for the previous 24 hours.

**Body composition.** Body weight and height were measured on a digital scale and stadiometer (Scale-Tronix model 5002), respectively. Waist circumference was measured at the umbilical level with a spring loaded Gulick measuring tape. Body composition was analyzed using dual energy x-ray absorptiometry (GE Lunar Prodigy Advance, software version 8.10e). Abdominal adiposity was measured via computed tomography (HiSpeed CT/I, GE Medical). The magneto-optical disc in which the CT scans were recorded was converted and placed onto a CD by DESACC (Portland, OR). Total, subcutaneous and visceral fat area between the L4-L5 vertebrae was quantified using the SliceOmatic 4.3 Rev-4 (TomoVision) software.

**Blood pressure.** Supine blood pressures were measured every 2.5 min during a 20 minute rest via an automated monitor (Colin PressMate), and were considered stable when at least 3 continuous measures were within 6 mmHg. Resting heart rate was obtained from lead II of an ECG.
**Dietary and physical activity assessment.** Dietary intake was assessed via self-reported 4-day food records completed at weeks 0, 4, 8 and 12. Energy and nutrient content of the diets was estimated with nutritional analysis software (NDS-R 2006, University of Minnesota). Accelerometers (GT1M, Actigraph, Inc) were worn at 0 and 12 weeks to assess habitual physical activity.

**Blood chemistry.** The Carillion Laboratory quantified the plasma lipid and lipoprotein concentrations using conventional techniques. The YSI 2300 Stat Plus glucose analyzer (Yellow Springs Instruments) was utilized to quantify plasma glucose mg/dl. Insulin concentrations were determined with a commercially available ELISA (Diagnostic Systems Laboratory).

**Arterial stiffness indices.** B-mode high resolution ultrasonography and applanation tonometry (Probe SPT-301, Millar Instruments) of the carotid artery were used to estimate the β-Stiffness Index (β-SI). Carotid artery diameters (1-2 cm from the carotid bulb) were measured from 5 diastolic and 5 corresponding systolic images (Vascular Research Tools 5, Medical Imaging Applications, LLC). The carotid artery waves, obtained via applanation tonometry during or right after the ultrasound, were calibrated using supine diastolic and mean arterial pressure to estimate central blood pressure. The known formula for β-SI was used to calculate local stiffness:\(^2\):

\[
\beta - SI = \frac{SBP}{DBP} + \frac{Diameter \ sys - Diameter \ dias (mm)}{Diameter \ dias (mm)}
\]

Carotid artery compliance was calculated with the following formula:
Carotid-Femoral pulse wave velocity (C-F PWV) measurements were obtained after 20 min of supine rest during which blood pressure was measured with an automated monitor (Colin PressMate). Applanation tonometry was used to simultaneously record the waveforms at the right carotid and femoral arteries. Distance between the above mentioned arteries was measured with a spring loaded Gulick tape measure to the nearest 0.5 cm. Arterial pressure waveforms (10-20 cardiac cycles) were analyzed using signal processing software (Windaq, Dataq Instruments). PWV was calculated as follows:

\[
PWV = \frac{Distance \ (linear \ path) \ between \ arterial \ sites (cm)}{Time \ of \ travel \ foot - to - foot \ of \ the \ pulse \ waves (s)}
\]

In addition, we report the estimated aortic PWV values obtained using the formula of Vermeersch et al. 30

**Statistical Analysis.** Data was tested for normality (Shapiro-Wilk’s test) and equality of variances (O’Brien Test). Independent samples t-tests were used to compare the subjects characteristics and outcome variables at baseline in the intervention and control group. Chi-squared analysis was used to compare the overall frequency of medication use between the two groups. To determine the effect of time, group, and time by group interaction, we performed repeated measures ANOVA on the dependent variables of interest. In addition, simple correlations were performed to observe probable pairwise associations among variables. Linear regression was used to determine if the changes in C-F PWV were independently affected by total and
abdominal adiposity. All of the data are reported as mean±SEM, and the significance level was set a priori at $P<0.05$.

**Results**

Table 1 shows the subjects’ characteristics at baseline and post-intervention according to group. At baseline, participants in the CON (n=11) and WL (n=25) group were overweight/obese with an average BMI of 31.8±1.4 and 30.0±0.6 Kg/m$^2$, respectively. Pre-intervention body weight, BMI, total body fat, abdominal fat, BP, lipid profile, glycemia, and insulin concentrations were similar in both groups (all $P>0.05$).

After the 12-week study period the WL group lost -7.1±0.7 Kg, which corresponds to -8.1±0.7% of their initial body weight. Abdominal fat measured via CT scans decreased significantly in the WL group (total -101.19±12.43, subcutaneous -54.98±8.81, visceral -44.23±7.54 cm$^2$). Resting brachial SBP, DBP and heart rate decreased in the WL group ($P<0.05$). There were no significant body weight, body composition, or brachial blood pressure changes in the CON group (all $P>0.05$). Carotid BP and PP decreased as a result of time in both groups, but the magnitude of change was not significant between groups.

Total cholesterol, LDL-cholesterol, and triglycerides decreased significantly in the WL group ($P<0.05$). No such changes were observed in the CON group, and HDL-cholesterol levels did not change in either group ($P>0.05$). Glucose levels ($P<0.05$) and insulin concentrations ($P=0.05$) only decreased in the WL group.

Table 2 shows the medication use of participants by group. The frequency of medication use was not different among the groups ($P>0.05$). None of the subjects
changed their medication use (dosage/frequency of intake) during the intervention and testing periods. All but one of the participants had been on the regimen for at least 1 year, and the other subject for 8 months.

Table 3 shows that there were no baseline differences in physical activity levels among the groups, and that habitual physical activity performed by each group did not differ after 12 weeks. Table 3 also shows the dietary intake data for both groups at baseline and post-intervention. Energy intake levels were maintained in the CON group, and decreased significantly in the WL group by approximately 600 Kcal ($P<0.05$). Percentage contribution of carbohydrates and fats to total energy intake in both groups remained similar to baseline. The percent of protein intake increased significantly only in the WL group ($P<0.05$). Both the CON and WL group consumed dietary cholesterol levels below the 300 mg/day recommendation. However, the WL group significantly reduced its cholesterol intake during the intervention period, as well as intake of saturated, monounsaturated, polyunsaturated and trans-fatty acids ($P<0.05$). Alcohol intake did not differ in either group after 12 weeks. Both sodium and potassium intake decreased significantly in the WL group during the intervention, the latter remaining within the reference levels. Magnesium intake for both groups remained unchanged after the intervention.

Table 4 presents the mean absolute values at baseline and post-testing for $\beta$-SI, arterial compliance, C-F PWV, and aortic PWV. There were no group differences in these arterial stiffness indices at baseline (all $P>0.05$). The changes in $\beta$-SI (CON, $0.52\pm0.37$ vs. WL, $-1.24\pm0.22$ U; Figure 1A), arterial compliance (CON, $-0.0056\pm0.0061$ vs. WL, $0.01250 \pm0.0038$ mm$^2$/mmHg x $10^{-1}$; Figure 1B), and C-F PWV (CON, 15±42
vs. WL, -187±29 cm/s) after the 12 week study period were greater in the WL group compared to CON. The observed reductions in β-SI and C-F PWV represent an arterial destiffening effect of 11.6% (carotid stiffness) and 16.2% (central stiffness), respectively, in the WL group. Importantly, The C-F distance did not change after the weight loss intervention (P>0.05), and the baseline and post-intervention distances were highly correlated (P<0.05).

In the pooled sample, the magnitude of change in β-SI correlated positively with the percent of initial body weight lost (Figure 4A), the change in BMI and the change in total body fat% (Table 5). The observed changes in C-F PWV were also associated to the percent weight loss (Figure 4B), the change in BMI and the change in body fat%. In addition to these variables, the magnitude of change in C-F PWV also correlated with the changes in the following variables: visceral fat (Figure 2C), waist circumference (Figure 2D), absolute weight loss (Kg), total fat mass, total and subcutaneous abdominal fat, total cholesterol and LDL-cholesterol (all P<0.05; Table 5). The magnitude of reduction in arterial compliance was inversely related to fat free mass (Table 5). No other variables, including SBP and DBP, correlated significantly with the observed reductions in β-SI, C-F PWV and arterial compliance. For example, Figure 3 shows that there is no correlation between the changes in mean arterial pressure and the changes in C-F PWV in either group.

Linear regression analysis demonstrated that when indices of total and abdominal adiposity are considered for inclusion, the changes in BMI, total weight loss, percent weight loss, and total fat loss are the only independent predictors of the magnitude of change in C-F PWV.
Discussion

The major finding of our study is that intentional weight loss via a hypocaloric diet alone (i.e., without modifying physical activity levels) reduces arterial stiffness in overweight/obese middle-aged and older adults. Body weight decreased in the WL group by approximately 8%, and the typical weight loss percent recommended to improve cardiovascular health is 5 to 10%. Reductions in body weight were accompanied by significant declines in β-SI (-12%) and C-F PWV (-16%), and increased arterial compliance (+10%). The degree of arterial destiffening was related to the magnitude of reduction in total body and abdominal adiposity. Nonetheless, only reductions in measures of total weight loss or total fat loss were able to independently predict the magnitude of improvement in arterial stiffness.

Few research groups have attempted to elucidate the effect of diet-induced weight loss on arterial stiffness. Most of the scientific evidence suggests that reductions in body weight via dietary interventions leads to improved arterial compliance (i.e., reduced arterial stiffness). However, methodological flaws and the use of other weight loss strategies in addition to diet make it difficult to draw conclusions about the potential destiffening effect of diet-alone therapy. To our knowledge, our study is the first randomized controlled trial to demonstrate that weight loss via diet-alone improves arterial stiffness in middle-aged and older adults. Our findings extend the results of previous studies (i.e., studies performed in young and middle-aged adults, normal weight and overweight individuals, adults with varying levels of physical activity, subjects with other morbidities) to obese middle-aged and older adults. Our findings are very relevant in the current context of the US population where the prevalence of
overweight and obesity is on the rise, adults are becoming more sedentary, and the older adult demographic is expected to double by 2030\textsuperscript{20}.

Our study was not designed to elucidate the mechanisms responsible for the weight loss induced reductions in arterial stiffness. However, several probable explanations exist. We believe that the destiffening effect observed after 12 weeks of weight loss is more likely a result of improvements in endothelial function as opposed to major quantitative structural changes. Nonetheless, it is possible that changes in the content of matrix proteins may have occurred and contributed to the reductions in arterial stiffness with weight loss. Future studies in animal models are needed to address this important issue.

Cross-linking of collagen and advanced glycation end-products significantly contributes to the age-related stiffening of large elastic arteries. Qualitative structural changes such as reductions in collagen cross-links occur over weeks to months. Therefore, whether weight loss might reduce arterial stiffness by decreasing the collagen cross-links is unclear and will depend on the duration of the intervention.

Improvements in endothelial function after weight loss have been demonstrated by reductions in endothelin-1\textsuperscript{22} and increased nitric oxide bioavailability\textsuperscript{22,28}. Aging and obesity are associated with many factors (i.e., free-fatty acids, inflammatory mediators, and reactive oxygen species) that impede nitric oxide production or bioavailability. In addition, angiotensin II and sympathetic nervous system activity is often increased in the obese state. Therefore, weight loss may improve arterial stiffness
by inducing changes in local, humoral, and neural activity factors that modulate the tone of the vascular smooth muscle \(^{31}\).

Reductions in PWV were associated with reductions in waist circumference and visceral fat in the present study. Visceral fat is characterized for having more adrenergic receptors, less functioning anti-lipolytic receptors, and higher expression of pro-inflammatory / atherogenic mediators compared with subcutaneous fat. Therefore, it is possible that the relationship between magnitude of change in visceral fat and arterial stiffness is a consequence of reductions in the local, humoral, and neural acivity factors mentioned above.

There are some limitations to this study that warrant discussion. The sample size was small and not powered to detect gender differences, the age range was restricted, and subjects were mostly Caucasian. Therefore, our findings may not be generalized and further research with diverse populations is needed to confirm and extend our results.

Our diet-induced weight loss intervention was of relative short duration (12 weeks) and it is unclear if the observed reductions in arterial stiffness are a result of acute changes in body weight and whether the improvements in arterial stiffness are sustained long-term. To address this issue, post-intervention sessions were completed after at least 2 weeks of weight stability.

Finally, we cannot exclude the possibility that the reductions in arterial stiffness were a result of reductions in blood pressure and sodium intake. However, the changes in systolic, diastolic and mean blood pressure were not related with the changes in
arterial stiffness. Furthermore, we observed a reduction in $\beta$-SI, a presumably blood pressure independent measure of local arterial stiffness, after the weight loss intervention.

We recently reported that daily intake of 80 mg of atorvastatin during 12 weeks reduced arterial stiffness in middle-aged and older adults $^{32}$. Interestingly, both our weight loss and statin interventions yielded similar reductions in central arterial stiffness (PWV= -160 to 190 cm/s). Even though substantial improvements in arterial stiffness were achieved in 12 weeks with both treatment approaches, the post-intervention values still remain higher than in healthy and younger individuals $^{33}$. The magnitude of reductions in arterial stiffness observed with both therapeutic strategies correlated with the degree of LDL-cholesterol lowering, among other variables in the weight loss study. Therefore, it is possible that weight reduction and high-dose statins decrease arterial stiffness by acting on common pathways, but at the same time these therapeutic strategies may target different mechanisms yielding greater cardiovascular health. Therefore, the potential of combination therapies (i.e., diet induced weight loss and statin) should be further studied to determine if there is an additive/synergistic effect in reducing CVD risk factors.

In conclusion, our findings suggest that WL reduces arterial stiffness in obese middle-aged and older adults. Furthermore, the magnitudes of these improvements are related to the loss of total and abdominal adiposity. Thus, weight loss may be an effective therapeutic strategy for altering the course of vascular aging in higher CVD risk populations such as obese middle-aged and older adults. Further research is needed to investigate if the observed improvement in arterial stiffness after 12 weeks of weight
loss is sustained long term or if there is a rebound effect. We conducted follow-up measurements of arterial stiffness in 8/25 participants from the weight loss intervention at 6-8 months post weight loss to try to gain some insight on this issue (unpublished pilot data). Their body weight at baseline, post-weight loss intervention and at follow-up was 84.2±4.9 Kg, 75.9±3.5 Kg, and 74.8±4.0 Kg, respectively. After the weight loss intervention, C-F PWV decreased by 19% in these 8 subjects, and at 6 months C-F PWV was still about 13% lower than at baseline. The fact that C-F PWV levels are well below baseline levels at the 6-8 month follow-up is encouraging from a nutritional therapy point of view. However, it should be noted that these individuals participated in a behavior based WTLM intervention that encouraged increasing physical activity and healthy eating, so this subset of participants may not be representative of the overall population.

Other important research questions are: Does the destiffening effect observed with weight loss follow a dose-response pattern? Can the level of arterial stiffness in obese individuals be reduced to that of an age-matched healthy individual if sufficient weight is lost long-term? Important advances have been made in the arterial stiffness research field but many questions remain to be answered regarding which are the best treatment options and which are the underlying mechanisms of action for these.

Acknowledgements

We thank the participants for their time, effort, and commitment to the study.
Sources of Funding

This study was supported by an American Heart Association Grant-in-Aid (to K.P.D).

Disclosures

None.

References


is associated with atherosclerosis of the coronary arteries in older adults: The rotterdam study. *J Hypertens*. 2006;24:2371-2376


29. Yamashita T, Sasahara T, Pomeroy SE, Collier G, Nestel PJ. Arterial compliance, blood pressure, plasma leptin, and plasma lipids in women are
improved with weight reduction equally with a meat-based diet and a plant-based

30. Vermeersch SJ, Rietzschel ER, De Buyzere ML, Van Bortel LM, Gillebert TC,
Verdonck PR, Laurent S, Segers P, Boutouyrie P. Distance measurements for
the assessment of carotid to femoral pulse wave velocity. *J Hypertens.*
2009;27:2377-2385

31. Zieman SJ, Melenovsky V, Kass DA. Mechanisms, pathophysiology, and therapy

32. Orr JS, Dengo AL, Rivero JM, Davy KP. Arterial destiffening with atorvastatin in
overweight and obese middle-aged and older adults. *Hypertension.* 2009;54:763-
768

33. Orr JS, Gentile CL, Davy BM, Davy KP. Large artery stiffening with weight gain in
humans: Role of visceral fat accumulation. *Hypertension.* 2008;51:1519-1524
Table 1. Subject characteristics before and after the control or weight loss intervention.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Control</th>
<th>Weight Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(5 females, 6 males)</td>
<td>(16 females, 9 males)</td>
</tr>
<tr>
<td></td>
<td>Pre</td>
<td>Post</td>
</tr>
<tr>
<td>Age, y</td>
<td>66.1±1.8</td>
<td>--</td>
</tr>
<tr>
<td>Body weight, kg</td>
<td>91.0±4.8</td>
<td>90.4±4.9</td>
</tr>
<tr>
<td>Body mass index, kg/m²</td>
<td>31.8±1.4</td>
<td>31.5±1.5</td>
</tr>
<tr>
<td>Waist circumference, cm</td>
<td>109.1±3.4</td>
<td>109.2±3.6</td>
</tr>
<tr>
<td>Body fat, %</td>
<td>39.3±3.0</td>
<td>39.3±2.9</td>
</tr>
<tr>
<td>Total fat mass, kg</td>
<td>32.5±2.5</td>
<td>32.4±2.4</td>
</tr>
<tr>
<td>Fat Free Mass, kg</td>
<td>51.0±4.0</td>
<td>50.9±4.0</td>
</tr>
<tr>
<td>Total abdominal fat, cm²</td>
<td>611±58</td>
<td>603±51</td>
</tr>
<tr>
<td>Abdominal subcutaneous fat, cm²</td>
<td>391±44</td>
<td>382±38</td>
</tr>
<tr>
<td>Abdominal visceral fat, cm²</td>
<td>188±18</td>
<td>186±17</td>
</tr>
<tr>
<td>Brachial SBP, mmHg</td>
<td>132±3</td>
<td>128±2</td>
</tr>
<tr>
<td>Brachial DBP, mmHg</td>
<td>74±2</td>
<td>73±1</td>
</tr>
<tr>
<td>Brachial MAP, mmHg</td>
<td>93±2</td>
<td>92±2</td>
</tr>
<tr>
<td>Brachial PP, mmHg</td>
<td>58±2</td>
<td>55±3</td>
</tr>
<tr>
<td>Carotid SBP, mmHg</td>
<td>120±3</td>
<td>117±2</td>
</tr>
<tr>
<td>Carotid PP, mmHg</td>
<td>45±2</td>
<td>43±3</td>
</tr>
<tr>
<td></td>
<td>Mean ± SE</td>
<td>Mean ± SE</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Heart rate, bpm</td>
<td>57±2</td>
<td>57±3</td>
</tr>
<tr>
<td>Triglycerides, mg/dL</td>
<td>97±17</td>
<td>108±22</td>
</tr>
<tr>
<td>Total cholesterol, mg/dL</td>
<td>192±5</td>
<td>193±4</td>
</tr>
<tr>
<td>HDL cholesterol, mg/dL</td>
<td>51±7</td>
<td>50±7</td>
</tr>
<tr>
<td>LDL cholesterol, mg/dL</td>
<td>122±6</td>
<td>122±5</td>
</tr>
<tr>
<td>Glucose, mg/dL</td>
<td>87±5</td>
<td>90±5</td>
</tr>
<tr>
<td>Insulin, pmol/L</td>
<td>45±8</td>
<td>45±9</td>
</tr>
</tbody>
</table>

All values are expressed as mean ± SEs. BP, blood pressure; PP, pulse pressure; HDL, high-density lipoprotein; LDL, low-density lipoprotein; VLDL, very low-density lipoprotein. Effect of time (*), group (†); and time x group interaction (‡), P<0.05. Group effect (§) P=0.05.
<table>
<thead>
<tr>
<th>Group</th>
<th>Medication</th>
<th>Female</th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>HRT</td>
<td>2</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Plavix</td>
<td>----</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>HCTZ</td>
<td>1</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Lisinopril</td>
<td>----</td>
<td>1</td>
</tr>
<tr>
<td>Weight Loss</td>
<td>HRT</td>
<td>2</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Flomax</td>
<td>----</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Avodart</td>
<td>----</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Dyazide</td>
<td>----</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Lipitor</td>
<td>----</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Crestor</td>
<td>1</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Fosamax</td>
<td>2</td>
<td>----</td>
</tr>
</tbody>
</table>
Table 3. Physical activity and dietary intake before and after the control or weight loss intervention.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Control</th>
<th>Weight Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pre</td>
<td>Post</td>
</tr>
<tr>
<td>Physical activity, counts/day x 10^3</td>
<td>229±32</td>
<td>219±24</td>
</tr>
<tr>
<td>Kcal</td>
<td>1897±103</td>
<td>1770±154</td>
</tr>
<tr>
<td>Fat, %</td>
<td>37±2</td>
<td>38±1</td>
</tr>
<tr>
<td>Carbohydrates, %</td>
<td>46±3</td>
<td>46±2</td>
</tr>
<tr>
<td>Protein, %</td>
<td>16±1</td>
<td>16±1</td>
</tr>
<tr>
<td>Alcohol, %</td>
<td>3.5±1.0</td>
<td>2.5±1.2</td>
</tr>
<tr>
<td>Cholesterol, mg</td>
<td>226±27</td>
<td>244±37</td>
</tr>
<tr>
<td>SFA, g</td>
<td>24±2</td>
<td>24±3</td>
</tr>
<tr>
<td>MUFA, g</td>
<td>30±3</td>
<td>29±3</td>
</tr>
<tr>
<td>PUFA, g</td>
<td>19±2</td>
<td>16±2</td>
</tr>
<tr>
<td>TFA, g</td>
<td>5±1</td>
<td>5±1</td>
</tr>
<tr>
<td>Sodium, mg</td>
<td>3304±276</td>
<td>3034±285</td>
</tr>
<tr>
<td>Potassium, mg</td>
<td>2717±151</td>
<td>2627±221</td>
</tr>
<tr>
<td>Magnesium, mg</td>
<td>305±26</td>
<td>298±35</td>
</tr>
</tbody>
</table>

All values are expressed as mean ± SEs. SFA, saturated fatty-acids; MUFA, monounsaturated fatty-acids; PUFA, polyunsaturated fatty-acids; TFA, trans fatty-acids. Effect of time (*), group (†); and time x group interaction.
Table 4. Indices of arterial stiffness before and after the control or weight loss intervention.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Control Pre</th>
<th>Control Post</th>
<th>Weight Loss Pre</th>
<th>Weight Loss Post</th>
</tr>
</thead>
<tbody>
<tr>
<td>β-stiffness index, U</td>
<td>11.73±0.89</td>
<td>12.25±0.82</td>
<td>10.68±0.58</td>
<td>9.44±0.52‡</td>
</tr>
<tr>
<td>Arterial compliance, mm²/mmHg x 10⁻¹</td>
<td>0.126±0.011</td>
<td>0.120±0.010</td>
<td>0.120±0.014</td>
<td>0.133±0.012‡</td>
</tr>
<tr>
<td>C-F PWV, cm/sec</td>
<td>1176±76</td>
<td>1190±77</td>
<td>1155±46</td>
<td>968±36*‡</td>
</tr>
<tr>
<td>Aortic PWV, cm/sec</td>
<td>818±54</td>
<td>883±62</td>
<td>833±35</td>
<td>706±25*‡</td>
</tr>
</tbody>
</table>

All values are expressed as mean ± SEs. PWV, pulse wave velocity. Effect of time (*), group (†); and time x group interaction (‡), P<0.05. Aortic PWV was estimated using the equation developed by Vermeersch et al.³⁰
Table 5. Correlations between changes indices of arterial stiffness with the intervention and other variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>C-F PWV</th>
<th>β-SI</th>
<th>Arterial compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight loss, kg</td>
<td>0.602*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Weight loss, %</td>
<td>0.592*</td>
<td>0.340*</td>
<td>-----</td>
</tr>
<tr>
<td>BMI, kg/m²</td>
<td>0.618*</td>
<td>0.296</td>
<td>-----</td>
</tr>
<tr>
<td>Waist circumference, cm</td>
<td>0.519*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Body fat, %</td>
<td>0.386*</td>
<td>0.326</td>
<td>-----</td>
</tr>
<tr>
<td>Total fat mass, kg</td>
<td>0.482*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Fat free mass, kg</td>
<td>-----</td>
<td>-----</td>
<td>-0.357*</td>
</tr>
<tr>
<td>Total abdominal fat, cm²</td>
<td>0.461*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Abdominal subcutaneous fat, cm²</td>
<td>0.360*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Abdominal visceral fat, cm²</td>
<td>0.357*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Heart rate, bpm</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Triglycerides, mg/dl</td>
<td>0.298</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Total cholesterol, mg/dl</td>
<td>0.431*</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>LDL-cholesterol, mg/dl</td>
<td>0.356*</td>
<td>-----</td>
<td>-----</td>
</tr>
</tbody>
</table>

*P<0.05
FIGURE LEGENDS

Figure 1. Change in β-stiffness index following control and weight loss intervention (top panel). Change in arterial compliance following control and weight loss intervention (middle panel). Change in C-F pulse wave velocity following control and weight loss intervention (bottom panel). PWV=pulse wave velocity. Values are means±SE. *P<0.05 vs. control

Figure 2. Relation between changes in β-stiffness index and percent weight loss in the pooled sample (panel A); relation between changes in C-F pulse wave velocity and percent weight loss (panel B); relation between changes in C-F pulse wave velocity and changes in visceral fat (panel C); and relation between changes in C-F pulse wave velocity and changes in waist circumference (panel D). PWV=pulse wave velocity.

Figure 3. Relation between changes in mean arterial pressure and change in carotid-femoral pulse wave velocity. PWV=pulse wave velocity.
Figure 1

Δ Arterial Compliance (mm²/mmHg x 10⁻¹)

Δ β-Stiffness Index (U)

Δ C-F PWV (cm/s)

* indicates significance between Control and Weight Loss groups.
Figure 2

A  
\[ \Delta \beta \text{-Stiffness Index (U)} \]
\[ -6 \quad -4 \quad -2 \quad 0 \quad 2 \quad 4 \]
\[ -20 \quad -15 \quad -10 \quad -5 \quad 0 \quad 5 \]

B  
\[ \Delta \text{C-F PWV (cm/s)} \]
\[ -600 \quad -500 \quad -400 \quad -300 \quad -200 \quad -100 \quad 0 \quad 100 \quad 200 \quad 300 \]
\[ -20 \quad -15 \quad -10 \quad -5 \quad 0 \quad 5 \quad 10 \]

C  
\[ \Delta \text{C-F PWV (cm/s)} \]
\[ -500 \quad -400 \quad -300 \quad -200 \quad -100 \quad 0 \quad 100 \]
\[ -160 \quad -140 \quad -120 \quad -100 \quad -80 \quad -60 \quad -40 \quad -20 \quad 0 \quad 20 \quad 40 \quad 60 \]

D  
\[ \Delta \text{Visceral Fat (cm²)} \]
\[ -500 \quad -400 \quad -300 \quad -200 \quad -100 \quad 0 \quad 100 \]
\[ -160 \quad -140 \quad -120 \quad -100 \quad -80 \quad -60 \quad -40 \quad -20 \quad 0 \quad 20 \quad 40 \quad 60 \]

r = 0.34, P < 0.05

r = 0.36, P < 0.05

r = 0.59, P < 0.05

r = 0.52, P < 0.05
Figure 3

![Graph showing changes in MAP and C-F PWV with weight loss and control groups.](image)
CHAPTER IV:

Conclusions and Future Directions

Overweight and obesity are associated with many diseases such as cardiovascular diseases (CVD), diabetes, dyslipidemia, cancer, liver and kidney diseases, and arthritis. Hypertension is the most prevalent CVD, currently affecting 1 in 3 US adults. However, the prevalence of hypertension increases drastically with age. Hypertension is no longer accepted as a “normal” part of the aging process, and there are many lifestyle and pharmaceutical treatment strategies available. Practitioners often refer to hypertension as “essential hypertension” because the etiology of hypertension is commonly complicated and difficult to isolate. However, a potential downside to this umbrella term is that often pharmaceutical treatment will target the “effect (i.e. high blood pressure)” but not the “cause” of the disease. In addition, the efficacy of the treatment may be evaluated inappropriately at peripheral arteries instead of centrally.

Increased systolic and decreased diastolic blood pressure, widening of the pulse pressure, decreased coronary perfusion, left ventricle hypertrophy, and increased cardiac workload are some of the hemodynamic consequences of arterial stiffening. In turn, arterial stiffness may be caused by one or several of the following factors: aging, obesity, visceral obesity, sympathetic nervous system, components of the renin-angiotensin II-aldosterone system, decreased nitric oxide bioavailability, activity of local vasodilators and constrictors, inflammatory and oxidative stress, smoking, genetics,
among other contributing factors. Importantly, arterial stiffness is considered an independent predictor of CVD morbidity and mortality.

Arterial stiffness measurements have been mostly used in research settings; nonetheless, there are non-invasive validated techniques that could easily be incorporated into a clinical setting (i.e., cardiologist’s office). Therefore, it may be of greater clinical value to target reductions in arterial stiffness, especially in central large-elastic arteries, than to focus on lowering brachial blood pressure. Treatment of arterial stiffness is similar to that of obesity and other chronic diseases in the sense that lifestyle modifications should always be the first approach. However, if lifestyle modifications are not yielding the expected results or if the patient has a higher CVD profile then pharmaceutical treatment should be added.

The purpose of our research was to determine if a hypocaloric diet alone based on the USDA food pyramid guidelines would reduce arterial stiffness in overweight and obese middle-aged and older adults. We controlled the possible confounding effect of physical activity by instructing all participants to not alter their habitual physical activity levels, and this was evaluated via the use of accelerometers. The rationale for choosing this population for our study is that because of their age (lifetime exposure to risk factors), obese state (usually associated with clustering of metabolic risk factors), and sedentary activity habits they are likely to have higher levels of arterial stiffness putting them at a greater risk for an adverse cardiovascular event.

In accordance with our hypothesis, arterial stiffness indices were reduced significantly after the intervention in those participants assigned to the weight loss
group. Most importantly, the reductions in arterial stiffness were achieved after a moderate weight loss of 8%, which is within the 5-10% weight reduction that is normally recommended for improving cardiovascular health. Pooled correlations indicate that the magnitude of reduction in arterial stiffness (C-F PWV) correlated significantly with changes in percent weight loss, waist circumference and visceral adiposity (CT scans). Nonetheless, changes in total body and abdominal fat did not predict the magnitude of change in C-F PWV in our population. Interestingly, even though blood pressure decreased with weight loss, changes in C-F PWV were not associated with changes in systolic, diastolic or mean blood pressure. Seemingly blood pressure independent reductions in arterial stiffness have also been reported by other research groups.

Our findings are motivational in the sense that middle-aged and older adults were successful in losing significant weight over 12-weeks, and as a result benefited from improved arterial compliance. Further studies are needed to determine if the improvements in arterial compliance would be sustained with long-term weight loss maintenance. In addition, it would be interesting to examine if this population would further benefit from combination therapies (i.e., weight loss, exercise and drugs), or if there is a limit to how much arterial stiffness may be reversed.

Other very interesting research questions are: 1) What impact does the duration of disease, in this case obesity, have on the efficacy of arterial destiffening treatments? For instance, would those with prolonged obesity be more resistant to certain types of arterial destiffening treatment, or to arterial stiffness reversibility overall? 2) How does weight cycling throughout someone’s lifetime affect arterial stiffness development? Do
some people eventually become resistant to destiffening strategies due to a weight cycling effect?
APPENDICES

Appendix A: Measurement of Arterial Stiffness Indices

A. Pulse Wave Velocity (Carotid-Femoral or Carotid-Radial)

PWV = Distance (cm) / Time (s)

Figure A1. Illustration of the arterial segment measured for the quantification of carotid-femoral PWV.

Equipment set-up

Note: The balance for channel 1 and channel 2 should be kept permanently at 500.

1. Turn on the Millar box (back) and the other box next to it.

2. Open Windaq USBO from the start menu.

3. Move the tool box to the upper right corner.
4. Go to Edit → Sample rate and type “800” → OK

5. Go to Edit → Select channels → Unclick channel 2 and select channel 6.

Only channels 5 and 6 should be selected.

6. Go to View → Format screen → Choose 2 waveforms

7. With the Millar box on “stand by”, click the save button on the toolbox → Select the folder where the data will be stored.

8. Change the File size to 2500 for longer recording time.

9. Status at the bottom will read “Record” → calibrate by pressing the 25 mmHg and 100 mmHg buttons on the Millar Box. First press the 25 mmHg button and a box will start forming, then press it again to stop, and press the 100 mmHg button and make a box of similar width to that of 25 mmHg. Repeat this sequence resulting in 25-100-25-100 mmHg boxes → click the save icon on the tool box to stop recording. See figure A2.

![Figure A2. Calibration of the Windaq software.](image-url)


**Patient Set-up**

1. Before starting the set-up for the PWV session make sure that the participant has met the following conditions:
   
   - 12 hour fast
   - No intake of prescription or over the counter drugs during the last 24-48 hours.
   - No illness during the previous week.
   - No exercise 24 hours before testing.

2. Ask the participant if he/she needs to use the restroom.

3. Briefly remind the participant what the session entails.

4. Clean the area for ECG lead placement by scraping with sand-paper and wiping with alcohol. Place the 3 leads and make sure the ECG shows up correctly on the ultrasound machine monitor. To adjust the ECG gain select “physio” and rotate the knob where “ECG gain%” is displayed.

5. Put the blood pressure cuff on the left arm and set the cuff interval to 2.5

6. Offer the participant a blanket and allow them to rest. Ask them to relax but not fall asleep, and to not cross their feet. If the participants are older or have back problems, offer to place a pillow underneath the knees and a blanket.

7. Dim the lights and leave the room or sit there quietly. Check the blood pressures 10 min into the session and at 20 min. If the person seems to be nervous or easily startled it may be better to remain in the room.
8. If blood pressures are stable after the 15-20 min rest, the session may be started.

9. While obtaining the measurements do not engage in conversation with the participant.

10. When ready to record a waveform, set the Millar box to “Transducer” and once a good quality image is obtained click the save button to record.

11. Once the session is finalized close the file. Always do this before turning off the Millar and the other box because if not Windaq will freeze the computer.

12. Wipe the tonometer tip with an alcohol wipe, let it dry and put away. If the femoral artery was measured always clean the tonometer.

**Pulse wave velocity analysis**

1. Open master file (Windaq)

![Figure A3. Example of pulse waves recorded at the carotid (top) and femoral (bottom) artery (master file).](image)
2. Browse the entire master file before selecting the pulse waveforms to be analyzed, and check the subject’s chart for notes. It is possible that several recordings exist for the same arterial segment of interest, and they could be out of order in the master file.

3. If waves are not visible for one of the channels, click on that channel and scroll up or down to find them. To scroll, click on the channel screen and drag the cursor to make a rectangle and click inside it, hold the left mouse button down and move the mouse in the desired direction. Adjust wave size by using the “up” and “down” arrows.

4. Choose the waves to be analyzed → Place the cursor before the 1st wave of interest → Hit F4 twice and at the bottom of the screen it will read .0000 SEC → a mark will appear → move the cursor 25-30 waves past the 1st selected wave.

5. Press F7 → compression 1
6. “Save as” → verify the option reads: visible and binary (with CODAS header) → Save the new file as: subjectID_CF_session# (date may be included, CR-PWV=CR)

7. Exit the master file without making changes to it, i.e., “exit with no save” option.

8. Open the newly created Windaq file.

9. Go to File → Calculate → Save all → blue screen pops-up → Type the “C” key (copy channel) → Enter → ESCape. See figure A6 below.

Figure A6. Example of the Windaq command screen.
10. A new blue screen pops-up to specify which channel is going to be copied and what channel will contain the new copy.

Destination channel: usually channel 3 → Enter → Enter source channel: select channel 1 (contains the carotid waveform) → Choose continue to “copy” the other channel with the distal artery wave recordings [repeat steps; destination channel=4, and source channel=2 (distal artery)] → Exit the blue screen.

11. Go to File → Calculate → Save all → the blue screen appears again → Hit the “P” key (Peak detector) → ESC

12. Enter channel number to capture: 1 (original channel) → Channel to be marked: 3 (the copied channel) → Select capture mode V (valley) → Leave threshold as is → ESC

![Waveform Peak and Valley with CALC](image)

Figure A7. Example of the command screen used to mark the channels to be analyzed.

13. Repeat steps for the distal artery channel → Exit the blue screen

14. Go to View → Format screen → choose 4 waveforms. The original and copied channels will appear. Channels 3 and 4 will be marked at the ascending foot of each wave.
15. Return to a 2 waveform view → channels 1 and 2 are automatically shown → Go to view → assign channel 1=3 and 2=4 to view the copied/marked channels.

Figure A9. Marked carotid and radial (bottom) pulse waves for peripheral PWV determination.

17. Go to View  Format screen  select 2 waveforms overlapped. Click on the channels to flatten the waves with the “down” arrow.

Examine the gap between the carotid and femoral (or radial) artery marks to make sure they are not exactly over each other or that there are no exaggerated gaps between some of them.

18. Go to View  Format screen  select 2 waveforms. Use the “up” arrow to unflatten them.

19. To move from mark to mark (foot-to-foot): hold down the control key and use the left and right arrows. The size of the waves can be changed by using the “up” and “down” keys if needed. Analyze the contour and the mark on each wave to determine if it is acceptable or if it should be deleted. To delete place the cursor right on top of the mark and press delete. Make sure to also delete the wave in the other channel.

20. To insert a mark: place the cursor in the desired spot (beginning of the upstroke find lowest voltage- use compression 1 to verify spot) and press “insert” twice.

Note: Optimally there are 20 quality waves selected at the end of the revision. But this may not be the case because of deleted waves (quality over quantity), just make sure that at least 10-12 waves are available for data.

21. To record the pulse travel times: move from the ascending foot of one wave to another and write down the time shown in the lower left corner [DATA 6.265 SEC (TBF)].
22. Exit from the file by selecting “save all”.

B. Ultrasound methods

Patient set-up

Follow the instructions for the PWV session.

US machine set-up

1. Power on

2. Insert optimal disc

3. Select “Patient id” → enter the subject’s id, gender, and session (DOB and other info are optional).

4. Press “Patient id” to exit.

5. Place a towel and the transducer gel next to the US machine.

6. To finish a session: press “disk” and “end study”.

7. Power off the US machine.

Ultrasound imaging and calibration of the carotid artery blood pressure

Note: Image is obtained at the left common carotid artery. At the same, the right carotid waveform is recorded via applanation tonometry(make sure to get at least 10 waves of similar amplitude). If pulse wave tonometry is not obtained at the same time of the US proceed to record the carotid artery waveforms immediately after the US.
1. Select 10* carotid waveforms from the master file → save → exit without saving.

*If 10 good quality carotid pulse waves are not available then choose as many as you can, try not to use less than 4 waves to calibrate the carotid blood pressure.

2. Open the windaq file of interest. Go to File → Calculate → Save all → blue screen pops-up → Type the “C” key to copy the channel containing the carotid artery waveforms → Enter → ESCape.

3. Go to File → Calculate → Save all → the blue screen appears again → Hit the “P” key (Peak detector) → Enter the channel to be marked and the source channel → Select “PV” (peak-valley) → Exit.

Verify that the first and last mark is a “valley” (if not delete “peak” or insert a “valley”), and review the placement of the marks.

Figure A10. Calibration of the carotid artery blood pressure using applanation tonometry and brachial blood pressure measured via an automated monitor.
4. Go to File → Calculate → Save all → Type the “G” key (Generate Point-Value Data File) → Enter → ESCape.

5. A new blue screen pops-up to specify which channel is going to be reported → report channel 3 → select “VV” (valley to valley).

6. Import data into excel. Go to Data → Import external data → Find the Windaq file (Folder: view All files and it has a blue squiggly icon) → Delimited → Tab and comma → Finish

7. Average the valley, peak and mean (4 decimals). Shift the decimal place of the valley and mean to the right and use 2 decimals, i.e., 2.0834 = 20.83

8. Return to Windaq and press F9 (low calibration). Input level = valley (aa.bb); low calibration value = brachial diastolic blood pressure (average of the resting blood pressures once stabilized).

9. Press F11 (high calibration). Input level = mean (xx.yy); high calibration value = mean arterial pressure (calculated from the average resting bp, USE 2 decimals).

10. Go to File → Calculate → Save all → Type the “G” key (Generate Point-Value Data File) → Enter → ESCape.

11. Report channel 3 → select “VV” (valley to valley).

12. Import the generated report into the excel file (same as above). Average the valley, peak and mean (no decimals), these values are the diastolic, systolic, and mean blood pressure, respectively. Save the excel file and delete the blue squiggly Windaq file.
Image retrieval (Manual method):

1. Open Q lab

2. Click on the folder and find the file in the E drive.

3. If several images are recorded for the same session, usually the last one (check date and time) is the better quality one; nonetheless, look at the others to double check.

4. Do not adjust the contrast of the image or the brightness to avoid altering the diameters.

5. Play the recorded US.

6. Goal: select 5 images (15 frames) of diastolic and systolic diameters. Preferably if they are sequential, but when needed it is OK to skip one.

7. To determine the diameter of interest it is necessary to scroll down the film strip and determine by eye the diameter changes, and use the ECG tracing to confirm.

Note: Given that sometimes the diameter changes are subtle, it is recommended to save the selected frame and the one before and after to ensure the correct diameter was chosen.

8. Save the frame either as a single frame TIF or JPEG using the command with a computer icon and film strip.
**Image analysis**

1. Open carotid analyzer

2. File → new → select image file

Note: Only fill the subject id and condition (common).

3. Calibrate the image by placing the “calibration bulls-eye” directly on top of the calibration points, it usually reads around 0.060 mm/pixel and marker distance is 10mm.

![Calibration step for the determination of arterial diameters.](image)

4. Press the light bulb button to select the region of interest (ROI), try to analyze 10 mm. THE ROI may be smaller than 10 mm, but try not to have it smaller than 4 mm (own judgement)

5. Align the ROI with the artery direction, choose an area that is about 2 cm from the carotid bulb on the right side (see figure A12) → Next
6. Diameters are obtained from M-line to M-line. First, the software will place the lines where it believes the M-lines go → Proceed

7. Results section. Display option: unclik “show I-lines” (yellow lines).

Figure A13. Calculation of an arterial diameter.
8. Select the “man” button. By default it says click to detect M-lines, leave as is.

Select “manual” to edit the diameters manually.

9. Sensitivity: select the small arrow or the middle one, if purple lines are accurately over the M-lines there is no need to edit them. If not, click the left mouse button to displace the M-lines altogether. Then click on a corner of the M-line (ROI) and then start clicking along the line to place the purple line correctly along the M-line.

10. Once both M-lines are edited, click on finish. Record the diameter (save as .sdy)

11. Record the heart rate of the images analyzed.

Note: Do the same for all the images. For further questions, read the Vascular Research Tools manual to better understand the process (saved on desktop)

Turn off computer and then turn off the optical disk reader.
Appendix B: Informed Consent for Subjects

Information Sheet (Version 2)
Department of Human Nutrition, Foods and Exercise
Virginia Tech

TITLE: Weight Loss in Older Adults

INVESTIGATORS: Brenda M. Davy, PhD, RD; Kevin Davy, PhD; Janet Rankin, PhD

MEDICAL DIRECTOR: Jose Rivero, M.D.

PURPOSE
You are being asked to participate in an experimental research study. Before you agree to be a volunteer in our study, we want you to understand what your participation will involve. Please read this form thoroughly prior to your first visit and let us know if you have any questions about its contents. The following information describes the study and your role as a participant.

The incidence of obesity is higher in older Americans (over age 60) than in the overall adult population (over age 18). Increased body weight is associated with higher risk for chronic diseases such as heart disease, diabetes, and cancer, as well as functional disabilities that may limit independence with advancing age. It is therefore important to study weight loss in older adults, and how this may improve heart health.

Seventy five people will participate in this study. To participate, you must be between the ages of 55 and 75 and be overweight. If you smoke, have been told by a doctor that you have a major chronic disease, for example, diabetes, cancer, chronic lung disease, kidney disease or thyroid disease, or if you are taking drugs that could affect your weight or appetite, you may not participate in this study. If the questionnaires that you fill out for us suggest that you have an eating disorder or that you may be depressed, you will not be able to participate in the study. Finally, if you have food allergies you may not be able to participate.

Following completion of the 12-week weight loss study, you have the option of continuing your research study participation for a 12-month weight loss maintenance follow-up study. A major challenge in the treatment of obesity is maintenance of weight loss. Many dieters regain about one third of the weight lost during the next year and are typically back to baseline in three to five years. Therefore, our purpose with this component of the study is to determine effective strategies for weight loss maintenance.

PROCEDURES
If you are interested in participating in this study, you will be required to visit War Memorial Hall for initial screening tests. You would be randomly assigned (like flipping a coin) to one of three groups. Two of these groups will be prescribed a low-calorie diet to help with weight loss for 12 weeks, but the two groups will receive different dietary instructions for losing weight. The third group will be a control group; individuals assigned to this control group will undergo all study procedures but will be asked not to change their diet or exercise habits. After 12 weeks, the people in the control group will be given the option of participating in a 12-week weight loss intervention if they would like to. All participants will also be required to eat two breakfast meals in the laboratory to measure your feelings of hunger and fullness before starting weight loss, and two more breakfast meals at the end of the 12-week weight loss period. You will be asked not to change your current physical

activity habits (exercise routine) during your participation in the 12-week low-calorie diet phase of the study.

There will be approximately 15-20 visits to the Human Nutrition, Foods, and Exercise Department (228 War Memorial Hall) at Virginia Tech; 2 visits will take place at Montgomery Regional Hospital. All of these visits will take place over a 4-month period. The actual number and order of visits may vary depending upon your schedule and the availability of the study staff. All study procedures described in this document are done at no cost to participants.

Session 1 (2 hours): First we will explain the study to you, and have you read this information sheet. If you choose to participate, the following screening tests will be done:

Health History – you will be asked to complete a medical history questionnaire. This procedure is used to screen for pre-existing disease or other reasons you should not participate in this study. Your height and weight will also be measured at this time. Your body weight will be measured on a standard balance scale and will include the weight of light indoor clothing or hospital gown without your shoes. Blood Pressure - You will be asked to sit quietly for 15 minutes. We will then measure your resting blood pressure using a stethoscope and standard blood pressure cuff and an blood pressure monitor. Eating Habits and Depression Questionnaires – you will complete two questionnaires that will be used to assess your eating habits and feelings of depression. If your scores on these questionnaires suggest that you may be depressed or have an eating disorder, you will be provided with contact information for the VT Psychological Services Center at 231-6914. You would be responsible for any costs related to follow-up care, if you decide to seek it. 4-Day Food Record – you will be given instructions for how to record your food and beverage intake for four consecutive days. This may take you about 10-15 minutes total time each day. You will turn this in at the next visit.

Session 2 (2 hours): You will be asked to avoid eating for 12 hours prior to this visit so that the test results will not be influenced by the food you eat or by the normal digestion process. Blood Draw – a needle will be inserted into an arm vein to draw blood (approximately 2 tablespoons) to measure the levels of cholesterol and glucose. An additional 3 teaspoons will be frozen for other blood tests which may include levels of blood hormones which influence your appetite and risk of cardiovascular disease. The tests will be restricted to those relevant to the research project described. Any blood samples remaining after 10 years will be destroyed. Body Fat Analysis - A test called a DEXA will be done to measure your percent body fat. For this test, you will have to lie very still on a table for about 20 minutes while your body is scanned, similar to having an x-ray. You will need to wear shorts and a t-shirt for this visit. Women should not wear bras with metal underwires. There is no pain associated with this test. 24-Hour Urine Collection – you will be given a container for collecting your urine for a 24-hour period. We will give you instructions for how to do this test, and you will be asked to keep your urine collection refrigerated (we will provide coolers with freezer packs to help with this). Food Record - you will turn in your food record at this visit. Blood Flow in Heart and Arteries – the blood flow and diameter in the arteries in your neck, arm and leg will be measured with an ultrasound machine. An ultrasonic machine is sort-of like radar – a low frequency radio wave that bounces off the tissues and sends a picture back to a "TV-like" screen. A mobile hand unit used will be pressed gently against an artery in your neck, arm and leg. The amount of blood that your heart pumps in one minute and other measures of heart function will be determined with another ultrasound probe. For these measurements, the probe will be pressed gently against two different places on your chest. Your blood pressure will also be measured.
**Session 3 (3 hours):** You may not eat or drink anything except water for 12 hours prior to this visit. We will measure your weight when you arrive for this visit, and you will return your urine collection from visit 2. This visit will be scheduled in the morning, typically beginning between 8a and 10:30a.

- **Breakfast Meal:** you will be provided with a breakfast meal consisting of typical breakfast items (muffins, jam, fruit, etc). You may eat as much as you like.
- **Visual Analog Scales (VAS):** Visual Analog Scales (VAS) are ratings of hunger, fullness, thirst and desire to eat. They consist of questions such as "How hungry are you right now?" to address hunger, thirst, nausea, and fullness. You will be asked to complete VAS at 6 time points on each testing day: 30 minutes before the meal, immediately before and after meal, and 30, 60 and 90-minutes after the meal.

**Session 4 (4 hours):** This visit will be similar to visit 3. You may not eat or drink anything except water for 12 hours prior to this visit. We will measure your weight when you arrive for this visit. This visit will be scheduled in the morning, typically beginning between 8a and 10:30a.

- **Breakfast Meal:** you will be provided with a breakfast meal consisting of typical breakfast items (muffins, jam, fruit, etc). You may eat as much as you like.
- **Visual Analog Scales (VAS):** Visual Analog Scales (VAS) are ratings of hunger, fullness, thirst and desire to eat. They consist of questions such as "How hungry are you right now?" to address hunger, thirst, nausea, and fullness. You will be asked to complete VAS at 6 time points on each testing day: 30 minutes before the meal, immediately before and after meal, and 30, 60 and 90-minutes after the meal.
- **Weight Loss Diet:** at this visit, you will be instructed in a low-fat (20-30% fat), low-calorie diet which should help you lose weight. We will individualize this diet for you so that it takes into account factors like your dietary preferences and body size. We will provide you with sample menus to use during this part of the study. You will be asked to follow this diet for 12 weeks. During the 12-week period, we will check your weight each week and provide you with assistance/feedback and tips for adhering to your diet. We will also ask you for urine samples every other week to see how well hydrated you are (the amount of fluid in your body).

**Session 5 (1 hour):** This visit will take place at Montgomery Regional Hospital. You will be asked to avoid eating for at least 4 hours prior to this visit.

- **Computed Tomography Scan:** the amount of total fat, fat around your internal organs, and the fat under the skin in the abdominal area will be measured by computed tomography (CT scan). The CT scan imaging will be performed at Montgomery Regional Hospital. For this procedure, you will be asked to lie still on a table. An x-ray machine (the CT scanner) will rotate around you and the table will move back and forth slightly making it possible to take X-rays from several angles. The actual x-ray time is approximately 2 minutes or less. You will be lying on the table for approximately 15 to 30 minutes. The approximate time required for the entire procedure is one hour. A longer period of time may be required due to heavy scheduling and/or emergency need of the CT scan at the Montgomery Regional Hospital.

**Sessions 6-16 (15-30 minutes each):** Once you begin your diet, you will be asked to come into the lab every 1-2 weeks to be weighed and have your blood pressure taken, and we will ask you if you are having any problems with following your diet that we can help you with. Every other week, you will be asked to keep another 24-hour urine collection and record everything that you eat and drink.

**Session 17 (2 hour):** This session will be the same as session 2.

**Sessions 18 and 19 (3 hours each):** This session will be the same as session 3.
Session 20 (1 hour): This session will be the same as session 5.

The total time commitment for this study will range from approximately 24-27 hours.

OPTIONAL STUDY EXTENSION: 12-Month Weight Maintenance

At the conclusion of sessions 17 through 20, if you are interested in participating in this study, you will begin a one year study that assesses strategies to help maintain weight lost during the first part of this research study. As with the first part of the study, the two weight loss maintenance groups will receive slightly different guidance on how to maintain their weight loss. Both groups will receive information on ways to increase physical activity.

There will be approximately 12-15 visits to the Human Nutrition, Foods and Exercise Department (228 War Memorial Hall) at Virginia Tech. All of these visits will take place over a one-year period. The actual number and order of visits may vary depending upon your schedule and the availability of the study staff. In addition to visits, all study participants will have to submit brief weekly health logs via e-mail, fax, phone or face to face. This will take approximately 5-10 minutes of your time each week. As with the first part of the study, all study procedures described in this part of the study are done at no cost to participants.

Session 21 (15-30 minutes): This session may be combined with session 19 of the phase 1 study. We will explain the 12-month study to you, and have you re-read this information sheet. If you choose to participate, the following screening test will be done. Health Belief Questionnaire – you will be asked to complete a Health Belief Model questionnaire. This procedure is used to assess subject’s knowledge of health behaviors and perceptions of positive behavior change.

Session 22 (1 hour): You will be asked to avoid eating and drinking for 12 hours prior to this visit. You will be asked to come to the lab early in the morning, well-rested and having avoided strenuous activity 12 hours prior this visit.

Resting Metabolic Rate – your resting metabolic rate is the amount of energy (calories) expended while at a resting state. For this test, you will have to lie very still on a table for 45 minutes to 1 hour while breathing into a transparent apparatus that covers your head and shoulders. Normal clothes can be worn. There is no pain associated with this test.

Sessions 23-27 (15-30 minutes): Once you begin your weight maintenance, you will be asked to come into the lab every month to be weighed and have your blood pressure taken, and we will ask you if you are having any problems with following your diet that we can help you with. You will be asked to complete a 4-Day Food Record each month, as well as an activity record. These monthly sessions will take place during your initial 6 months of weight maintenance.

Session 28 (2 hours): This session will be similar to session 2, and it will take place in the morning. You may not eat or drink anything for 12 hours prior to this visit. We will measure your weight when you arrive for this visit. The visit will be scheduled in the morning, typically between 8a and 10:30a. This session will take place during your sixth month of weight maintenance.

Sessions 29-34 (15-30 minutes): This session will be the same as sessions 23-27, and take place in months 7-12 of weight maintenance.

Session 35 (2-3 hours): This session will be the same as session 28 with the addition of resting metabolic rate. This session will take place in the final month of the 12-month weight maintenance phase.
Session 36 (1 hour): This session will be to provide you with an analysis of your participation in the weight maintenance study, such as your test results, and answer further questions.

SUMMARY OF SUBJECT RESPONSIBILITIES

- Provide an accurate history of any health problems or medications you use before the study begins.
- Inform the experimenters of any discomfort or unusual feelings before, during or after any of the study sessions.
- Be on time and attend all of the scheduled sessions.
- Follow all participant instructions for each session.
- Not change current physical activity levels.
- Record the food you eat as instructed by the study investigators.

RISKS OF PARTICIPATION

- Blood Draw: Some pain or discomfort may be experienced when the needle is inserted in the vein, but this persists for only a short time. During the blood draws, you may have pain and/or bruising at the place on your arm where the blood is taken. In about 1 in 10 or 10% of the cases, a small amount of bleeding under the skin will cause bruises. The risk of a blood clot forming in the vein is about 1 in 200 (0.005%), while the risk of infection or significant blood loss is 1 in 1000 (0.001%). There is a small risk of the vein becoming inflamed and/or painful in the hours or days after the catheter is removed. If you feel faint during or after a blood draw, you should notify the study staff immediately and lie down right away to avoid falling down. Having staff who are experienced in blood draws will minimize these risks.
- HIV/AIDS: Your blood will be tested for the presence of HIV if one of the study investigators is exposed to your blood. There will not be any cost to you for this test. The results will be sent to your primary care physician or the study medical director, Dr. Jose Rivero, if you do not have a primary care physician. He/she will discuss them with you and provide you with the necessary referral for further evaluation and/or counseling if your results are positive. The results of your test will remain confidential.
- DEXA Scan: The amount of radiation that you will receive in the DEXA exam is less than the amount permitted by the Food and Drug Administration (FDA) per year. The amount you will receive is equal to 1/20 of a chest x-ray. The more radiation you receive over the course of your lifetime, the more likely your risk increases in developing cancerous tumors. The radiation in this study is not expected to greatly increase these risks, however the exact increase in such risk is not known.
- CT scan: The amount of radiation that you will receive in the CT scan (combined with the DEXA exam) is less than the amount permitted by the Food and Drug Administration (FDA) per year. The amount you will receive is less than that received from a chest x-ray. The more radiation you receive over the course of your lifetime, the more likely your risk increases in developing cancerous tumors. The total amount of x-ray exposure from both the DEXA and CT scan is less than a chest x-ray. The radiation in this study is not expected to greatly increase these risks, however the exact increase in such risk is not known. You should know that the CT scan for this study is for research purposes and not for diagnosis. The CT scan will be not be reviewed or saved for future purposes by Montgomery Regional Hospital.
- Weight Gain: Weight gain is common following weight loss programs. It is possible that you will gain some or all of the weight you lost during the study. We can make no promises or commitments on the long term success of maintaining your weight loss. This is a possibility that you should consider before you agree to participate.
- It is not possible to identify all potential risks in an experimental study, however the study doctors and study staff will take all possible safeguards to minimize any known and
potential risks to your well-being. We believe the overall risks of participation are minimal. All of the procedures are well established and used routinely in the study investigators laboratory. Side effects are possible in any research study despite high standards of care, and could occur through no fault of your own or the study staff.

**BENEFITS OF PARTICIPATION**
Your participation will provide you with:
- Information on your body composition and diet
- Information on a low fat weight loss diet, supervised by a registered dietitian
- Support, information and feedback for weight loss maintenance, if you choose to participate in the optional 12-month follow-up part of the study.

**COMPENSATION**
We will pay you $50 for completion of all sessions involved with the 12-week study. If you dropout of the study or are unable to complete the study, you will be paid a prorated amount for those sessions you complete ($2.50 per session completed). You will not be paid for completing the 12-month optional follow-up study.

**CONFIDENTIALITY**
The data from this study will be kept strictly confidential. No data will be released to anyone but those working on the project without your written permission. Data will be identified by subject numbers, without anything to identify you by name.

**FREEDOM TO WITHDRAW**
You are free to withdraw from the study at any time for any reason. Simply inform the experimenters of your intention to cease participation. Circumstances may come up that the researcher will determine that you should not continue as a subject in the study. For example, lack of compliance to instructions, failure to attend testing sessions and illness could be reasons for the researchers to stop your participation in the study.

**INJURY DURING PARTICIPATION IN THIS STUDY**
Neither the researchers nor the university have money set aside to pay for medical treatment that would be necessary if injured as a result of your participation in this study. Any expenses that you incur including emergencies and long-term expenses would be your own responsibility. You should consider this limitation before you consider participating in this study.

**APPROVAL OF RESEARCH**
This research has been authorized, as required, by the Institutional Review Board for Research Involving Human Subjects at Virginia Tech, and by the Department of Human Nutrition, Foods, and Exercise. You will receive a copy of this form to take with you.

**SUBJECT PERMISSION**
I have read the informed consent and fully understand the procedures and conditions of the project. I have had all my questions answered, and I hereby give my voluntary consent to be a participant in this research study. I agree to abide by the rules of the project. I understand that I may withdraw from the study at any time.

If you have questions, you may contact:
- Principal Investigator: Brenda Davy, Assistant Professor, Department of Human Nutrition, Foods, and Exercise. (540) 231-6784
- Co-Investigator: Kevin Davy, Associate Professor, Department of Human Nutrition, Foods, and Exercise. (540) 231-3487

*VT IRB – This document is valid from 17 July 2007 – 16 July 2008.*
Name of Subject (please print) ________________________________

Signature of Subject ________________________________ Date ______

Name of Person Obtaining Consent (print) ________________________________

Signature of Person Obtaining Consent ________________________________ Date ______
Appendix C: Institutional Review Board Approval

C.1 IRB Full Approval

DATE: September 22, 2006

MEMORANDUM

TO: Brenda M. Davy, Kevin P. Davy, Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Amendment 1 Approval: "Weight Loss In Older Adults", IRB # 06-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB on July 17, 2006. You subsequently requested permission to amend your IRB application. Since the requested amendment is non-substantive in nature, I, as Chair of the Virginia Tech Institutional Review Board, have granted approval for requested protocol amendment, effective as of September 21, 2006. The anniversary date will remain the same as the original approval date.

As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.
2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.
3. Report promptly to the IRB of the study's closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher's responsibility to obtain re-approval from the IRB before the study's expiration date.
4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
C.2 IRB Amendment 1 Approval

DATE: July 20, 2006

MEMORANDUM

TO: Brenda M. Davy
    Kevin P. Davy
    Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Full IRB Approval: "Weight Loss In Older Adults", IRB # 06-372

The above referenced protocol was submitted for full review and approval by the IRB at the July 17, 2006 meeting. The board had voted approval of this proposal contingent upon receipt of responses to questions raised during its deliberation. Following receipt and review of your responses, I, as Chair of the Virginia Tech Institutional Review Board, have, at the direction of the IRB, granted approval for this study for a period of 12 months, effective July 17, 2006.

Approval of your research by the IRB provides the appropriate review as required by federal and state laws regarding human subject research. As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.

2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.

3. Report promptly to the IRB of the study's closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher's responsibility to obtained re-approval from the IRB before the study's expiration date.

4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

Important:
If you are conducting federally funded non-exempt research, this approval letter must state that the IRB has compared the OSP grant application and IRB application and found the documents to be consistent. Otherwise, this approval letter is invalid for OSP to release funds. Visit our website at http://www.irb.vt.edu/pages/newstudy.html#OSP for further information.

cc: File
C.3 IRB Amendment 2 Approval

DATE: November 1, 2006

MEMORANDUM

TO: Brenda M. Davy  
    Kevin P. Davy  
    Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Amendment 2 Approval: “Weight Loss In Older Adults”, IRB # 06-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB on July 17, 2006. You subsequently requested permission to amend your IRB application. Since the requested amendment is nonsubstantive in nature, I, as Chair of the Virginia Tech Institutional Review Board, have granted approval for requested protocol amendment, effective as of November 1, 2006. The anniversary date will remain the same as the original approval date.

As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.

2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.

3. Report promptly to the IRB of the study’s closing (i.e., data collecting and analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher’s responsibility to obtain re-approval from the IRB before the study’s expiration date.

4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
C.4 IRB Amendment 3 Approval

DATE: May 21, 2007

MEMORANDUM

TO: Brenda M. Davy
    Kevin P. Davy
    Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Amendment 3 Approval: "Weight Loss In Older Adults", IRB # 06-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB on July 17, 2006. You subsequently requested permission to amend your IRB application. Since the requested amendment is nonsubstantive in nature, I, as Chair of the Virginia Tech Institutional Review Board, have granted approval for requested protocol amendment, effective as of May 21, 2007. The anniversary date will remain the same as the original approval date.

As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.
2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.
3. Report promptly to the IRB of the study's closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher's responsibility to obtain re-approval from the IRB before the study's expiration date.
4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
DATE: July 20, 2007

MEMORANDUM

TO: Brenda M. Davy
    Kevin P. Davy
    Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Full Review Continuation 1: "Weight Loss In Older Adults", IRB # 06-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB. The proposed research, having been previously approved at a convened IRB meeting, required full IRB review prior to granting an extension of approval, according to the specifications authorized by 45 CFR 46.110 and 21 CFR 56.110. The above referenced protocol was submitted for full review, continuation and approval by the IRB at its most recent meeting. Pursuant to your request, I, as Chair of the Virginia Tech Institutional Review Board, have, at the direction of the IRB, granted approval for this study for a period of 12 months, effective July 17, 2007.

Approval of your research by the IRB provides the appropriate review as required by federal and state laws regarding human subject research. As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.
2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.
3. Report promptly to the IRB of the study’s closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher’s responsibility to obtain re-approval from the IRB before the study’s expiration date.
4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
DATE: July 17, 2008

MEMORANDUM

TO: Brenda M. Davy
    Kevin P. Davy
    Janet W. Rankin

FROM: David M. Moore

SUBJECT: IRB Full Review Continuation 2: "Weight Loss In Older Adults", OSP #455929, 455467, IRB # D6-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB. The proposed research, having been previously approved at a convened IRB meeting, required full IRB review prior to granting an extension of approval, according to the specifications authorized by 45 CFR 46.110 and 21 CFR 56.110. The above referenced protocol was submitted for full review continuation and approval by the IRB at a recent meeting. Pursuant to your request, I, as Chair of the Virginia Tech Institutional Review Board, have, at the direction of the IRB, granted approval for this study for a period of 12 months, effective July 17, 2008.

Approval of your research by the IRB provides the appropriate review as required by federal and state laws regarding human subject research. As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.
2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.
3. Report promptly to the IRB of the study's closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher's responsibility to obtain re-approval from the IRB before the study's expiration date.
4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
    OSP
DATE: July 13, 2009

MEMORANDUM

TO: Brenda M. Davy
Kevin P. Davy
Janet W. Rankin
FROM: David M. Moore

SUBJECT: IRB Full Review Continuation 3: "Weight Loss In Older Adults", OSP #455929, 456467, IRB # 06-372

This memo is regarding the above referenced protocol which was previously granted approval by the IRB. The proposed research, having been previously approved at a convened IRB meeting, required full IRB review prior to granting an extension of approval, according to the specifications authorized by 45 CFR 46.110 and 21 CFR 56.110. The above referenced protocol was submitted for full review continuation and approval by the IRB at a recent meeting. Pursuant to your request, I, as Chair of the Virginia Tech Institutional Review Board, have, at the direction of the IRB, granted approval for this study for a period of 12 months, effective July 17, 2009.

Approval of your research by the IRB provides the appropriate review as required by federal and state laws regarding human subject research. As an investigator of human subjects, your responsibilities include the following:

1. Report promptly proposed changes in previously approved human subject research activities to the IRB, including changes to your study forms, procedures and investigators, regardless of how minor. The proposed changes must not be initiated without IRB review and approval, except where necessary to eliminate apparent immediate hazards to the subjects.

2. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.

3. Report promptly to the IRB of the study's closing (i.e., data collecting and data analysis complete at Virginia Tech). If the study is to continue past the expiration date (listed above), investigators must submit a request for continuing review prior to the continuing review due date (listed above). It is the researcher's responsibility to obtain re-approval from the IRB before the study's expiration date.

4. If re-approval is not obtained (unless the study has been reported to the IRB as closed) prior to the expiration date, all activities involving human subjects and data analysis must cease immediately, except where necessary to eliminate apparent immediate hazards to the subjects.

cc: File
OSP
Appendix D: Citation of the published manuscript